
Corporate Headquarters
Cisco Systems, Inc.
170 West Tasman Drive
San Jose, CA 95134-1706
USA
http://www.cisco.com
Tel: 408 526-4000

800 553-NETS (6387)
Fax: 408 526-4100

Cisco IP SoftPhone User Guide
Version 1.2

Text Part Number: OL-1599-02

http://www.cisco.com


THE SPECIFICATIONS AND INFORMATION REGARDING THE PRODUCTS IN THIS MANUAL ARE SUBJECT TO CHANGE WITHOUT 
NOTICE. ALL STATEMENTS, INFORMATION, AND RECOMMENDATIONS IN THIS MANUAL ARE BELIEVED TO BE ACCURATE BUT 
ARE PRESENTED WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED. USERS MUST TAKE FULL RESPONSIBILITY FOR 
THEIR APPLICATION OF ANY PRODUCTS.

THE SOFTWARE LICENSE AND LIMITED WARRANTY FOR THE ACCOMPANYING PRODUCT ARE SET FORTH IN THE 
INFORMATION PACKET THAT SHIPPED WITH THE PRODUCT AND ARE INCORPORATED HEREIN BY THIS REFERENCE. IF YOU 
ARE UNABLE TO LOCATE THE SOFTWARE LICENSE OR LIMITED WARRANTY, CONTACT YOUR CISCO REPRESENTATIVE FOR A 
COPY.

The Cisco implementation of TCP header compression is an adaptation of a program developed by the University of California, Berkeley (UCB) as 
part of UCB’s public domain version of the UNIX operating system. All rights reserved. Copyright © 1981, Regents of the University of California. 

NOTWITHSTANDING ANY OTHER WARRANTY HEREIN, ALL DOCUMENT FILES AND SOFTWARE OF THESE SUPPLIERS ARE 
PROVIDED “AS IS” WITH ALL FAULTS. CISCO AND THE ABOVE-NAMED SUPPLIERS DISCLAIM ALL WARRANTIES, EXPRESSED 
OR IMPLIED, INCLUDING, WITHOUT LIMITATION, THOSE OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND 
NONINFRINGEMENT OR ARISING FROM A COURSE OF DEALING, USAGE, OR TRADE PRACTICE.

IN NO EVENT SHALL CISCO OR ITS SUPPLIERS BE LIABLE FOR ANY INDIRECT, SPECIAL, CONSEQUENTIAL, OR INCIDENTAL 
DAMAGES, INCLUDING, WITHOUT LIMITATION, LOST PROFITS OR LOSS OR DAMAGE TO DATA ARISING OUT OF THE USE OR 
INABILITY TO USE THIS MANUAL, EVEN IF CISCO OR ITS SUPPLIERS HAVE BEEN ADVISED OF THE POSSIBILITY OF SUCH 
DAMAGES.

AccessPath, AtmDirector, Browse with Me, CCIP, CCSI, CD-PAC, CiscoLink, the Cisco Powered Network logo, Cisco Systems Networking 
Academy, the Cisco Systems Networking Academy logo, Fast Step, Follow Me Browsing, FormShare, FrameShare, GigaStack, IGX, Internet 
Quotient, IP/VC, iQ Breakthrough, iQ Expertise, iQ FastTrack, the iQ Logo, iQ Net Readiness Scorecard, MGX, the Networkers logo, Packet, 
RateMUX, ScriptBuilder, ScriptShare, SlideCast, SMARTnet, TransPath, Unity, Voice LAN, Wavelength Router, and WebViewer are trademarks 
of Cisco Systems, Inc.; Changing the Way We Work, Live, Play, and Learn, Discover All That’s Possible, and Empowering the Internet Generation, 
are service marks of Cisco Systems, Inc.; and Aironet, ASIST, BPX, Catalyst, CCDA, CCDP, CCIE, CCNA, CCNP, Cisco, the Cisco Certified 
Internetwork Expert logo, Cisco IOS, the Cisco IOS logo, Cisco Systems, Cisco Systems Capital, the Cisco Systems logo, Enterprise/Solver, 
EtherChannel, EtherSwitch, FastHub, FastSwitch, IOS, IP/TV, LightStream, MICA, Network Registrar, PIX, Post-Routing, Pre-Routing, Registrar, 
StrataView Plus, Stratm, SwitchProbe, TeleRouter, and VCO are registered trademarks of Cisco Systems, Inc. and/or its affiliates in the U.S. and 
certain other countries. 

All other trademarks mentioned in this document or Web site are the property of their respective owners. The use of the word partner does not imply 
a partnership relationship between Cisco and any other company. (0106R)

Cisco IP SoftPhone User Guide
Copyright © 2000–2001, Cisco Systems, Inc.
All rights reserved.



 

C O N T E N T S
Preface ix

Purpose ix

Audience x

Organization x

Related Documentation xi

System Requirements xi

Conventions xi

Cisco Connection Online xiii

Documentation CD-ROM xiv

C H A P T E R  1 Introducing Cisco IP SoftPhone 1-1

Using Cisco IP SoftPhone as a Stand-alone Phone 1-2

Using Cisco IP SoftPhone to Control a Cisco IP Phone 1-3

Using Cisco IP SoftPhone in Other Languages 1-4

Online Dialing and Directories 1-4

Alphanumeric Translation 1-4

Call Tracking 1-5

Audio Conferencing 1-5

Desktop Collaboration with Virtual Conference Room 1-6

Whiteboarding 1-6

Application and Document Sharing 1-7

Chat 1-8

Video Collaboration 1-8
iii
Cisco IP SoftPhone User Guide

OL-1599-02



 

Contents
Voice Mail Integration 1-9

Support for Cisco E911 Service 1-9

Network Components 1-10

System Requirements 1-10

Standards Support 1-12

C H A P T E R  2 Installing and Starting Cisco IP SoftPhone 2-1

Installing Cisco IP SoftPhone 2-2

Installing from a Web Page 2-2

Installing from a Self-extracting Executable 2-4

Installing from a CD-ROM 2-6

Starting Cisco IP SoftPhone 2-11

Exiting Cisco IP SoftPhone 2-13

C H A P T E R  3 Using Cisco IP SoftPhone 3-1

Selecting Lines to Control 3-2

Selecting Your Cisco IP Phone Line 3-3

Using the Main Dialing Window 3-4

Icon Bar 3-7

Context-Sensitive Button Bar 3-8

Line Buttons 3-10

Changing the Display 3-10

Volume Controls 3-11

Adjusting the Speaker Volume 3-12

Adjusting the Microphone Volume 3-13

Placing a Call 3-14

Dialing from the Online Keypad 3-15
iv
Cisco IP SoftPhone User Guide

OL-1599-02



Contents
Dialing from the Online Directories 3-16

Dialing the Last Number Dialed 3-17

Ending a Call 3-17

Answering a Call 3-17

Deflecting an Incoming Call 3-18

Sending an Incoming Call to Voice Mail 3-18

Ignoring an Incoming Call 3-19

Automatically Answering a Call 3-19

Placing a Call on Hold 3-20

Transferring a Call 3-21

Performing a Consult Transfer 3-21

Performing a Direct Transfer 3-22

Using Voice Mail 3-22

Configuring Your Voice Mailbox 3-22

Checking Voice Mail 3-23

Forwarding All Calls to Voice Mail 3-24

Starting an Audio Conference 3-25

Adding Participants to a Conference 3-26

Leaving a Conference 3-26

Playing .wav Files with Cisco IP SoftPhone 3-27

Using Auto-Greet Mode 3-27

Playing a .wav File to a Caller 3-28

Stopping a .wav File During a Call 3-28

Using the Dialing Directories 3-28

Adding a Directory Entry 3-29

Deleting a Directory Entry 3-31

Editing a Directory Entry 3-32
v
Cisco IP SoftPhone User Guide

OL-1599-02



 

Contents
Searching for a Directory Entry 3-32

Viewing Call History 3-32

Configuring Advanced Settings 3-33

C H A P T E R  4 Collaborating with Virtual Conference Room 4-1

Collaboration Checklist 4-1

Using the Roster 4-2

Using the Application Sharing Window 4-4

Starting a Document Sharing Session 4-5

Transferring Control of a Document 4-7

Requesting Control of a Document 4-9

Ending a Document Sharing Session 4-9

Starting a Whiteboard Session 4-10

Ending a Whiteboard Session 4-11

Whiteboard Synchronization 4-11

Sending a Chat Message 4-12

Preparing for a Video Collaboration Session 4-13

A P P E N D I X  A Troubleshooting A-1

Frequently Asked Questions (FAQs) A-1

When I Start Cisco IP SoftPhone, Why Don’t I See Any Lines to Control? A-2

Verifying the Cisco IP SoftPhone Configuration A-3

Verifying the Cisco TSP Configuration A-4

Restarting the Telephony Service A-6

Verifying Network Connectivity A-7

I Can See a Line But When I Try To Open it, Cisco IP SoftPhone Displays a 
'Could not open address' Error. A-7
vi
Cisco IP SoftPhone User Guide

OL-1599-02



Contents
Why Does the Audio Sound Jittery and Broken? A-8

Selecting the Proper Audio Drivers A-8

Why am I Getting One-way Audio? A-8

Full-duplex vs. Half-duplex Sound Cards A-9

Configuring Network Audio Settings A-10

Why Do I Get a “Could Not Initialize Audio Error” When I Start 
Cisco IP SoftPhone? A-13

Finding and Changing the IP Address for the Cisco CallManager A-14

Determining Which Cisco CallManager the Cisco IP SoftPhone is Using A-14

Changing the Cisco CalIManager IP address Configured for the 
Cisco IP SoftPhone A-15

Adjusting the Audio Settings A-16

Diagnosing Problems with Collaboration A-18

I N D E X
vii
Cisco IP SoftPhone User Guide

OL-1599-02



 

Contents
viii
Cisco IP SoftPhone User Guide

OL-1599-02



 

Preface

This preface describes the purpose, audience, organization, and conventions of 
this guide, and provides information on how to obtain related documentation.

The preface covers these topics:

• Purpose, page ix

• Audience, page x

• Organization, page x

• Related Documentation, page xi

• System Requirements, page xi

• Conventions, page xi

• Cisco Connection Online, page xiii

• Documentation CD-ROM, page xiv

Purpose
The Cisco IP SoftPhone User Guide provides instructions for installing, 
configuring, and using the Cisco IP SoftPhone. It will help you to:

• Understand the Cisco IP SoftPhone components and features

• Install and configure the Cisco IP SoftPhone on your Windows PC

• Use the Cisco IP SoftPhone to place, receive and control calls over an IP 
network
ix
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Audience
Audience
The Cisco IP SoftPhone User Guide is written for computer users who will be 
using their desktop PC to make and receive phone calls, do desktop collaboration, 
and/or control a Cisco IP Phone.

Organization
This guide is organized as follows:

Chapter Description

Chapter 1 “Introducing Cisco IP SoftPhone”

Describes the features, components, and system requirements for 
Cisco IP SoftPhone

Chapter 2 “Installing and Starting Cisco IP SoftPhone”

Describes how to install and start Cisco IP SoftPhone

Chapter 3 “Using Cisco IP SoftPhone”

Describes how to use Cisco IP SoftPhone to place, receive, and 
control calls from your desktop PC

Chapter 4 “Collaborating with Virtual Conference Room”

Describes how to use the desktop collaboration features of
Cisco IP SoftPhone

Appendix A “Troubleshooting”

Describes troubleshooting procedures for common problems you 
may encounter when using Cisco IP SoftPhone.
x
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Related Documentation
Related Documentation
Refer to the following documents for further information about 
Cisco IP SoftPhone and the Cisco CallManager. These documents can also be 
found online at www.cisco.com/univercd/cc/td/doc/product/voice/.

• Cisco IP SoftPhone Administrator Guide

• Cisco IP SoftPhone Quick Start Guide

• Cisco IP SoftPhone Release Notes

• Cisco CallManager Systems Guide

System Requirements
You can install Cisco IP SoftPhone on the following English, French, German and 
Japanese versions of Microsoft Windows:

• Windows 95

• Windows 98 SE

• Windows ME

• Windows NT 4.0 with Service Pack 4 or later

• Windows 2000

Conventions
This document uses the following conventions:

Convention Description

boldface font Commands and keywords are in boldface.

italic font Arguments for which you supply values are in italics.

[ ] Elements in square brackets are optional.

{ x | y | z } Alternative keywords are grouped in braces and separated 
by vertical bars.
xi
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Conventions
Notes use the following conventions:

Note Means reader take note. Notes contain helpful suggestions or references to 
material not covered in the publication.

Timesavers use the following conventions:

Timesaver Means the described action saves time. You can save time by performing the 
action described in the paragraph.

[ x | y | z ] Optional alternative keywords are grouped in brackets 
and separated by vertical bars.

string A nonquoted set of characters. Do not use quotation 
marks around the string or the string will include the 
quotation marks.

screen font Terminal sessions and information the system displays 
are in screen font.

boldface screen 
font

Information you must enter is in boldface screen font.

italic screen font Arguments for which you supply values are in italic 
screen font.

This pointer highlights an important line of text 

in an example.

^ The symbol ^ represents the key labeled Control—for 
example, the key combination ^D in a screen display 
means hold down the Control key while you press the D 
key.

< > Nonprinting characters, such as passwords are in angle 
brackets.

Convention Description
xii
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Cisco Connection Online
Tips use the following conventions:

Tip Means the following are useful tips.

Cautions use the following conventions:

Caution  Means reader be careful. In this situation, you might do something that could 
result in equipment damage or loss of data.

Warnings use the following conventions:

Warning This warning symbol means danger. You are in a situation that could cause 
bodily injury. Before you work on any equipment, you must be aware of the 
hazards involved with electrical circuitry and familiar with standard 
practices for preventing accidents. To see translated versions of the 
warning, refer to Appendix n, “Translated Safety Warnings.”

Cisco Connection Online
Cisco Connection Online (CCO) is Cisco Systems’ primary, real-time support 
channel. Maintenance customers and partners can self-register on CCO to obtain 
additional information and services.

Available 24 hours a day, 7 days a week, CCO provides a wealth of standard and 
value-added services to Cisco’s customers and business partners. CCO services 
include product information, product documentation, software updates, release 
notes, technical tips, the Bug Navigator, configuration notes, brochures, 
descriptions of service offerings, and download access to public and authorized 
files.

CCO serves a wide variety of users through two interfaces that are updated and 
enhanced simultaneously: a character-based version and a multimedia version that 
resides on the World Wide Web (WWW). The character-based CCO supports 
Zmodem, Kermit, Xmodem, FTP, and Internet e-mail, and it is excellent for quick 
xiii
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Documentation CD-ROM
access to information over lower bandwidths. The WWW version of CCO 
provides richly formatted documents with photographs, figures, graphics, and 
video, as well as hyperlinks to related information.

You can access CCO in the following ways:

• WWW: http://www.cisco.com

• WWW: http://www-europe.cisco.com

• WWW: http://www-china.cisco.com

• Telnet: cco.cisco.com

• Modem: From North America, 408 526-8070; from Europe, 
33 1 64 46 40 82. Use the following terminal settings: VT100 emulation; 
databits: 8; parity: none; stop bits: 1; and connection rates up to 28.8 kbps.

For a copy of CCO’s Frequently Asked Questions (FAQ), contact 
cco-help@cisco.com. For additional information, contact cco-team@cisco.com.

Note If you are a network administrator and need personal technical assistance with 
a Cisco product that is under warranty or covered by a maintenance contract, 
contact Cisco’s Technical Assistance Center (TAC) at 800 553-2447, 
408 526-7209, or tac@cisco.com. To obtain general information about Cisco 
Systems, Cisco products, or upgrades, contact 800 553-6387, 408 526-7208, 
or cs-rep@cisco.com.

Documentation CD-ROM
Cisco documentation and additional literature are available in a CD-ROM 
package, which ships with your product. The Documentation CD-ROM, a 
member of the Cisco Connection Family, is updated monthly. Therefore, it might 
be more current than printed documentation. To order additional copies of the 
Documentation CD-ROM, contact your local sales representative or call customer 
service. The CD-ROM package is available as a single package or as an annual 
subscription. You can also access Cisco documentation on the World Wide Web 
at http://www.cisco.com, http://www-china.cisco.com, or 
http://www-europe.cisco.com.
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Documentation CD-ROM
If you are reading Cisco product documentation on the World Wide Web, you can 
submit comments electronically. Click Feedback in the toolbar and select 
Documentation. After you complete the form, click Submit to send it to Cisco. 
We appreciate your comments.
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C H A P T E R 1

Introducing Cisco IP SoftPhone

Cisco IP SoftPhone is a desktop application that turns your computer into a 
full-feature telephone with the added advantages of call tracking, desktop 
collaboration, and one-click dialing from online directories. You can also use 
Cisco IP SoftPhone in tandem with a Cisco IP Phone to place, receive and control 
calls from your desktop PC. All features are functional in both modes of 
operation.

These sections introduce you to the features, components, and system 
requirements for Cisco IP SoftPhone:

• Using Cisco IP SoftPhone as a Stand-alone Phone, page 1-2

• Using Cisco IP SoftPhone to Control a Cisco IP Phone, page 1-3

• Using Cisco IP SoftPhone in Other Languages, page 1-4

• Online Dialing and Directories, page 1-4

• Call Tracking, page 1-5

• Audio Conferencing, page 1-5

• Desktop Collaboration with Virtual Conference Room, page 1-6

• Voice Mail Integration, page 1-9

• Support for Cisco E911 Service, page 1-9

• Network Components, page 1-10

• System Requirements, page 1-10

• Standards Support, page 1-12
1-1
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Chapter 1      Introducing Cisco IP SoftPhone
Using Cisco IP SoftPhone as a Stand-alone Phone
Figure 1-1 shows the main components of the Cisco IP SoftPhone.

Figure 1-1 Cisco IP SoftPhone

Using Cisco IP SoftPhone as a Stand-alone Phone
You can use Cisco IP SoftPhone as a stand-alone phone to place and receive all 
calls through your computer rather than your Cisco IP Phone. In this mode, the 
media stream is terminated by your computer. This means that your computer 
“rings” when you have an incoming call and you need to use a computer headset 
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2 Lines 4 Context-sensitive button bar
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Chapter 1      Introducing Cisco IP SoftPhone
Using Cisco IP SoftPhone to Control a Cisco IP Phone
or computer handset to speak and listen during a call. The microphone and 
speaker volume is controlled by the volume controls on the Cisco IP SoftPhone 
user interface.

When you use Cisco IP SoftPhone as a stand-alone phone, you can take your 
phone extension with you and receive calls wherever you are connected to the 
corporate network. For example, when you are on a business trip, you can use 
Cisco IP SoftPhone to place and receive calls and check voice mail while online.

To use Cisco IP SoftPhone as a stand-alone phone, your PC must have a 
full-duplex sound card with the proper drivers installed, and a computer headset 
or computer handset. Use of the PC’s speakers is not recommended as it may 
introduce echo.

Related Topics

• Using Cisco IP SoftPhone to Control a Cisco IP Phone, page 1-3

• Selecting Your Cisco IP Phone Line, page 3-3

Using Cisco IP SoftPhone to Control a 
Cisco IP Phone

You can use Cisco IP SoftPhone in tandem with a Cisco IP Phone, allowing you 
the flexibility of controlling calls from your computer or from your 
Cisco IP Phone. Both devices reflect the same current call state.

For example, you can accept an incoming call by picking up the Cisco IP Phone 
handset and then place the call on hold using the Cisco IP SoftPhone application. 
Both the Cisco IP Phone and the Cisco IP SoftPhone will reflect the fact that the 
call is on hold.

In this mode, the media stream is terminated by the Cisco IP Phone. This means 
that the Cisco IP Phone rings when you have an incoming call and you need to use 
the telephone handset to speak and listen during a call. The microphone and 
speaker volume is controlled by the volume controls on the Cisco IP Phone, rather 
than the volume controls provided with Cisco IP SoftPhone.

Related Topics

• Using Cisco IP SoftPhone as a Stand-alone Phone, page 1-2

• Selecting Your Cisco IP Phone Line, page 3-3
1-3
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Using Cisco IP SoftPhone in Other Languages
Using Cisco IP SoftPhone in Other Languages
You have the flexibility to use Cisco IP SoftPhone in languages such as English, 
French, and German.

During installation, you can select the language in which you would like to run 
Cisco IP SoftPhone. As a result, text in the Cisco IP SoftPhone graphical user 
interface and dialog boxes will appear in the language of your choice. When you 
run Cisco IP SoftPhone, you can switch to another language at any time.

Related Topic

• Configuring Advanced Settings, page 3-33

Online Dialing and Directories
Cisco IP SoftPhone enables you to place phone calls using directory servers, web 
pages, and your computer keyboard. It integrates with the directory service used 
by the Cisco CallManager, allowing you to place calls by dragging a name from 
the corporate directory to the dialing window. To setup a conference call, simply 
drag names from the directory into the dialing window.

You can add names to your personal directory by dragging an active call into the 
directory. Cisco IP SoftPhone will automatically add the caller ID to your 
directory.

Related Topics

• Alphanumeric Translation, page 1-4

• Using the Dialing Directories, page 3-28

• Dialing from the Online Directories, page 3-16

Alphanumeric Translation
Cisco IP SoftPhone translates alphanumeric dialing strings into keypad digits. 
For example, if you enter 1-800-GOCISCO, Cisco IP SoftPhone will correctly 
translate the dial string to 1-800-462-4726. The values for ‘Q’ and ‘Z’ are 
translated to ‘7’ and ‘9’ respectively.
1-4
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Call Tracking
Call Tracking
Whenever you place or receive a call, Cisco IP SoftPhone displays the caller 
address, caller name, and phone number for the duration of the call. It also logs 
this information to a call log. You can view the call log at any time to see an 
up-to-date history of your calls, including missed calls. The call log keeps track 
of which line placed or received the call, the duration of the call, the type of call, 
and how the call ended. 

Related Topic

• Viewing Call History, page 3-32

Audio Conferencing
With Cisco IP SoftPhone, you can initiate a conference call simply by clicking the 
conference button and dragging a directory entry onto the active call block. 
Cisco IP SoftPhone provides full audio conferencing capabilities, allowing up to 
six parties to participate in a conference call. It supports full-duplex audio so 
people can speak simultaneously.

Once a conference call is established, you may add participants at any time. As 
participants are invited to join the conference, the Roster updates to show the 
current list of participants.

Related Topics

• Starting an Audio Conference, page 3-25

• Adding Participants to a Conference, page 3-26

• Leaving a Conference, page 3-26

• Using the Roster, page 4-2
1-5
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Chapter 1      Introducing Cisco IP SoftPhone
Desktop Collaboration with Virtual Conference Room
Desktop Collaboration with Virtual Conference 
Room

Cisco IP SoftPhone includes a desktop collaboration utility called Virtual 
Conference Room. Using Virtual Conference Room, you can create online 
meetings where all parties can be heard and any party can share a document, 
application, or whiteboard, with other participants. Only one computer needs to 
have the program, and any participant can be given control of the document. 
Additionally, you can integrate with Microsoft NetMeeting for video and other 
modes of collaboration.

These sections describe the Virtual Conference Room desktop collaboration 
features of Cisco IP SoftPhone:

• Whiteboarding, page 1-6

• Application and Document Sharing, page 1-7

• Chat, page 1-8

• Video Collaboration, page 1-8

• Chapter 4, “Collaborating with Virtual Conference Room”

Whiteboarding
The Virtual Conference Room whiteboard application allows everyone in a call or 
audio conference to draw and type simultaneously on a shared screen. When you 
press the whiteboard button, a whiteboard appears on the PC screen for each 
conference call participant. The whiteboard application includes tools you can use 
to add and delete whiteboard pages, draw shapes, type text, and emphasize an item 
with a highlighter or remote pointer.

You can also use the whiteboard application to copy and paste items between the 
whiteboard and other programs. Then, you can use the whiteboard’s tools to 
further illustrate the objects. Other meeting participants can see your work 
without having access to your desktop.
1-6
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Chapter 1      Introducing Cisco IP SoftPhone
Desktop Collaboration with Virtual Conference Room
Figure 1-2 shows and example of a whiteboard session.

Related Topics

• Using the Roster, page 4-2

• Starting a Whiteboard Session, page 4-10

• Ending a Whiteboard Session, page 4-11

• Whiteboard Synchronization, page 4-11

• Collaboration Checklist, page 4-1

Figure 1-2 Sample Whiteboard Session

Application and Document Sharing
The Virtual Conference Room application and document sharing feature allows 
meeting participants to view and work on files simultaneously. For example, you 
may want several people to work on the same Microsoft Word document. You can 
1-7
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Chapter 1      Introducing Cisco IP SoftPhone
Desktop Collaboration with Virtual Conference Room
open the document on your computer, share it, and then everyone can provide 
their comments directly in the document. Only the person who opened the file is 
required to have the program on their computer. Other participants can work on 
the document without having the program. All meeting participants can share 
programs during a meeting. The shared programs of each participant appear in 
separate shared program windows on the other participants’ desktops.

Related Topics

• Collaboration Checklist, page 4-1

• Using the Roster, page 4-2

• Using the Application Sharing Window, page 4-4

• Starting a Document Sharing Session, page 4-5

• Transferring Control of a Document, page 4-7

• Requesting Control of a Document, page 4-9

• Ending a Document Sharing Session, page 4-9

Chat
Cisco IP SoftPhone integrates with the Microsoft NetMeeting chat application, 
allowing you to send a text message to all or selected participants in an audio or 
video call. Chat is useful in a group meeting because everyone can “talk” to each 
other simultaneously. In an audio or video connection, only two people can talk 
at a time.

Related Topic

• Sending a Chat Message, page 4-12

Video Collaboration
Cisco IP SoftPhone integrates with Microsoft NetMeeting, allowing you to 
conduct video meetings. Even if you are unable to transmit video, you can still 
receive video calls in the NetMeeting video window.
1-8
Cisco IP SoftPhone User Guide

OL-1599-02



 

Chapter 1      Introducing Cisco IP SoftPhone
Voice Mail Integration
If you choose to use video or prefer the NetMeeting interface, you will need to 
disable Virtual Conference Room. See “Preparing for a Video Collaboration 
Session” section on page 4-13 for instructions on how to disable Virtual 
Conference Room. Once Virtual Conference Room is disabled, 
Cisco IP SoftPhone will place calls using the NetMeeting user interface. 

See the Microsoft NetMeeting online help and documentation for details on how 
to use the video collaboration features of NetMeeting.

Related Topic

• Preparing for a Video Collaboration Session, page 4-13

Voice Mail Integration
Cisco IP SoftPhone integrates with your voice mail system. It can transfer calls or 
place calls directly into a voice mailbox. When you have a voice mail message, 
the messages icon in the Cisco IP SoftPhone icon bar turns red until you check 
your messages. To dial your voice mailbox, simply click on the voice mail 
message icon.

Related Topics

• Using Voice Mail, page 3-22

• Sending an Incoming Call to Voice Mail, page 3-18

Support for Cisco E911 Service
Cisco IP SoftPhone 1.2 includes support for Cisco E911 service. Cisco E911 
service provides 911 dispatchers with your caller information such as phone 
number and location. You can operate Cisco IP SoftPhone with Cisco E911 
service if you are using Cisco CallManager 3.1(x) and the Cisco CallManager has 
been configured for Cisco E911 support. To find out whether you have 
Cisco E911 service, see your system administrator.
1-9
Cisco IP SoftPhone User Guide

OL-1599-02



 

Chapter 1      Introducing Cisco IP SoftPhone
Network Components
Network Components
Cisco IP SoftPhone uses the services of the Cisco CallManager to route calls 
through an IP telephony network. The Cisco CallManager is an open and 
industry-standard call processing system which integrates traditional PBX 
functionality with the corporate IP network. Cisco CallManager manages the 
components of the IP telephony system, the phones, access gateways, and the 
resources necessary for such features as call conferencing and route planning.

Your system administrator must configure a line for you and assign user 
permissions on the Cisco CallManager system before you can send and receive 
calls with the Cisco IP SoftPhone.

Figure 1-3 shows a diagram of the network components required for 
Cisco IP SoftPhone.

Figure 1-3 Cisco IP SoftPhone and the Cisco IP Telephony Network

System Requirements
Table 1-1 lists the system and network requirements for installing and using 
Cisco IP SoftPhone on your PC.

Cisco
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PC running 
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System Requirements
Table 1-1 Hardware and Software Requirements for Cisco IP SoftPhone

Item Requirement Notes

Operating system Microsoft Windows 95, 
Windows 98 SE (Second 
Edition), Windows NT 4.0 with 
Service Pack 4 or later, or 
Windows 2000.

English, French, German, and Japanese 
versions only.

Free disk space 40 MB

Temporary disk space 60 MB 20 MB is used only for installation (TEMP 
directory).

Processor Pentium II 266 MHZ A Pentium 166 MHZ MMX is sufficient if 
using only in phone control mode.

Memory 64 to 128 MB RAM Depends on which features are active.

Internet browser Microsoft Internet Explorer 4.01 
or later, or Netscape Navigator 
4.06 or later with Internet 
Explorer 4.01 or later also 
installed.

You do not need an internet browser to use 
Cisco IP SoftPhone; however, 
Cisco IP SoftPhone requires the Java 
Virtual Machine (JVM) which is included 
with Microsoft Internet Explorer. An 
internet browser is required to install 
Cisco IP SoftPhone from the web.

Sound card Microsoft Windows-compatible 
full-duplex sound card

If you have a USB1 microphone/headset, 
you will not need an additional sound 
card.
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Standards Support
Cisco IP SoftPhone supports the following networking and telephony standards:

• Telephony Application Programming Interface (TAPI) compliant

• T.120 via networking integration

• H.323

• G.711, G.723.1 and G.729A coder/decoder (codec) support

Computer headset or 
handset

Any PC-compatible headset or 
handset (microphone and 
headphone)

Required if you plan to use 
Cisco IP SoftPhone as a stand-alone 
application. A headset or handset is not 
required if you will be using 
Cisco IP SoftPhone to control a 
Cisco IP Phone.

Cisco IP SoftPhone is compatible with 
Plantronics headsets. See the following 
URL for details on how to obtain a 
Plantronics headset:

http://cisco.getheadsets.com

Microsoft NetMeeting 
client application

Version 3.01 Required if you plan to do desktop 
collaboration. NetMeeting is 3.01 is 
included as part of the Cisco IP SoftPhone 
installation.

1. Universal Serial Bus

Table 1-1 Hardware and Software Requirements for Cisco IP SoftPhone (continued)

Item Requirement Notes
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Installing and Starting 
Cisco IP SoftPhone

You can install the Cisco IP SoftPhone from a web page within your company’s 
intranet. If you do not have Internet access or are otherwise unable to install from 
the web page, you can download a self-extracting executable and run the 
installation locally. Alternatively, you can install Cisco IP SoftPhone from a 
CD-ROM.

The installation is quick and easy and requires little configuration. Your system 
administrator can pre-set the configuration information in administrator 
customization files so you can install and begin using Cisco IP SoftPhone right 
away.

The following sections help you to prepare for, install, and start 
Cisco IP SoftPhone:

• Installing Cisco IP SoftPhone, page 2-2

• Starting Cisco IP SoftPhone, page 2-11

• Exiting Cisco IP SoftPhone, page 2-13
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Installing Cisco IP SoftPhone
Depending on how your system administrator has set up Cisco IP SoftPhone on 
your network, you can install the Cisco IP SoftPhone using one of the following 
procedures:

• Installing from a Web Page, page 2-2

• Installing from a Self-extracting Executable, page 2-4

• Installing from a CD-ROM, page 2-6

Installing from a Web Page
Use this procedure to install Cisco IP SoftPhone from an intranet web page.

Note You can only use this procedure if you Cisco IP SoftPhone 
administrator has created a “one-click install” on your web server.

Before You Begin

• Install Microsoft Internet Explorer 4.01 or later.

You can download this browser from the Microsoft web site at 
http://www.microsoft.com/windows/ie/

• Obtain the following information from your network or system administrator:

– The URL for the Cisco IP SoftPhone installation files

– The username and password configured for you on the 
Cisco CallManager 

.Procedure

Step 1 Open a web browser and go to the URL where the Cisco IP SoftPhone installation 
files reside.

Step 2 If you are using Netscape Communicator, click Grant in the Java Security 
window.

Step 3 Choose the language in which you want to view Cisco IP SoftPhone.
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Step 4 Click the Install Now button.

Step 5 Read the software authenticy verification and click Next to begin the installation.

Step 6 If you are installing Cisco IP SoftPhone for the first time:

a. Click Next in the Welcome screen to begin the installation.

b. Read the software license agreement and then click Yes to accept the terms 
of the agreement.

c. Choose a destination to which you want to install Cisco IP SoftPhone and 
then click Next.

If are upgrading to a newer version of Cisco IP SoftPhone, choose Upgrade to a 
Newer Version and click Next in the Welcome screen.

Step 7 In the Local TSP Configuration screen, enter your username and password and 
then click Next.

Note The username and password you configure for Cisco IP SoftPhone 
must be exactly the same as the username and password assigned to 
you on the Cisco CallManager. 

Step 8 If you are installing Cisco IP SoftPhone for the first time, select a Program Folder 
to which you want the Installer to add icons.

By default, the Installer adds icons to a folder called Cisco IP SoftPhone.

Step 9 Click Next and follow the instructions on the screen.

Step 10 In the Install Wizard Complete dialog window, choose whether you want to 
restart your computer now or later, and click Finish to complete the installation.

You must restart your computer before you can begin using Cisco IP SoftPhone.
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Installing from a Self-extracting Executable
Use this procedure to install Cisco IP SoftPhone from a self-extracting 
executable. This installation procedure allows you to download 
Cisco IP SoftPhone to your local drive and install the program at a later time.

Before You Begin

• Install Microsoft Internet Explorer 4.01 or later.

You can download this browser from the Microsoft web site at 
http://www.microsoft.com/windows/ie/

• Obtain the following information from your network or system administrator:

– The URL for the Cisco IP SoftPhone installation files

– The username and password configured for you on the 
Cisco CallManager 

Procedure

Step 1 Open a web browser and go to the URL where the Cisco IP SoftPhone installation 
files reside.

Step 2 If you are using Netscape Communicator, click Grant in the Java Security 
window.

Step 3 Click the language in which you wish to install Cisco IP SoftPhone.

Step 4 Click download the Cisco IP SoftPhone installation.

The Cisco IP SoftPhone download instructions window appears with the URL 
where the Cisco IP SoftPhone customization files reside.

Step 5 Make a note of the URL which you will need to provide in step 13.

Step 6 Click Cisco IP SoftPhone to download the self-extracting executable.

Step 7 In the File download window, choose either to Run this program from its 
current location or Save this program to disk and then click OK.

If you select Run this program from its current location, skip to Step 10.

Step 8 Choose a destination to which you want to download the installation files and 
click Save.

Step 9 In the Download complete window, choose one of the following procedures:
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• Click Open to launch CiscoIPSoftPhoneSetup.exe and begin the 
installation.

• Click Open Folder and launch CiscoIPSoftPhoneSetup.exe from the folder.

• Click Close to launch CiscoIPSoftPhoneSetup.exe at a later time.

The dialog box shown in Figure 2-1 appears:

Figure 2-1 Choosing a Language for Cisco IP SoftPhone

Step 10 Choose the language in which you would like the installation screens to appear 
and click OK.

Step 11 Choose the destination to which you want to download the installation files and 
click Save.

Step 12 If you are installing Cisco IP SoftPhone for the first time:

a. Click Next in the Welcome screen to begin the installation.

b. Read the software license agreement and then click Yes to accept the terms 
of the agreement.

c. Choose a destination to which you want to install Cisco IP SoftPhone and 
then click Next.

If you are upgrading to a new version of Cisco IP SoftPhone, choose Upgrade to 
a Newer Version and click Next in the Welcome screen.

Step 13 In the Setup window, specify the URL where the customization files reside.

Caution If you do not specify the correct URL, you will not receive customization files 
such as Microsoft NetMeeting 3.01, Cisco TSP and Cisco IP SoftPhone 
settings. You need these files to run Cisco IP SoftPhone.
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Step 14 In the Local TSP Configuration screen, enter your username and password.

Note The username and password you configure for Cisco IP SoftPhone 
must be exactly the same as the username and password assigned to 
you on the Cisco CallManager. 

Step 15 Click Next

Step 16 If you are installing Cisco IP SoftPhone for the first time, select a Program Folder 
to which you want the Installer to add icons.

By default, the Installer adds icons to a folder called Cisco IP SoftPhone.

Step 17 Follow the instructions on the screen.

Step 18 In the Install Wizard Complete dialog window, choose whether you want to 
restart your computer now or later, and click Finish to complete the installation.

You must restart your computer before you can begin using Cisco IP SoftPhone.

Installing from a CD-ROM
Use this procedure to install Cisco IP SoftPhone from a CD-ROM.

Before You Begin

• Install Microsoft Internet Explorer 4.01 or later.

You can download this browser from the Microsoft web site at 
http://www.microsoft.com/windows/ie/

• Obtain the following information from your network or system administrator:

– The username and password configured for you on the 
Cisco CallManager

– The location of the customization files (if any) for the 
Cisco IP SoftPhone installation

– Whether your Cisco IP SoftPhone is configured with Cisco CallManager 
3.1(x) or Cisco CallManager 3.0(x)
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For Cisco CallManager 3.1(x): 

• The primary and backup CTI IP Manager addresses of the Cisco CallManager 
server you will be using

• Whether Cisco E911 service is configured on the Cisco CallManager

• If Cisco E911 is configured, the primary and backup server URLs for 
Cisco IP SoftPhone

Note For more information about Cisco E911 service, refer to the “Support 
for Cisco E911 Service” section on page 1-9.

For Cisco CallManager 3.0(x): 

• The IP address of the Cisco CallManager server you will be using.

Procedure

Step 1 Insert the installation CD-ROM and run Launch.exe to start the 
Cisco IP SoftPhone installation.

Step 2 In the Demonstration Language window shown in Figure 2-2, select the language 
in which you want to view the installation windows and click OK.

Figure 2-2 Choosing a Demonstration Language

Step 3 Click Install Products.

Step 4 Click the Cisco IP SoftPhone button.

The dialog box shown in Figure 2-3 appears:
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Figure 2-3 Choosing a Language for Cisco IP SoftPhone

Step 5 Choose the language in which you want to install Cisco IP SoftPhone from the 
drop-down menu and click OK.

The InstallShield wizard will launch and prepare for the installation.

Step 6 Click Next in the welcome screen to begin the installation.

Step 7 Read the software license agreement and then click Yes to accept the terms of the 
agreement.

Step 8 Choose a destination to which you want to install Cisco IP SoftPhone and then 
click Next.

By default, the installation program installs Cisco IP SoftPhone in the following 
directory:

C:\...\Cisco Systems\Cisco IP SoftPhone

Step 9 If you are using customization files:

• Enter the URL where the customization files reside and click Next. Refer to 
Figure 2-4.

If you are not using customization files:

• Leave the URL field blank and click Next.

The question box shown in Figure 2-5 will display.

• Click No.
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Figure 2-4 Specifying the Location of the Customization Files

Figure 2-5 Installing without Customization Files

Step 10 If E911 service is configured on the Cisco CallManager:

• Click Yes in the question box shown in Figure 2-6.

• Enter the primary and backup E911 server URLs and click Next.

If E911 service is not configured on the Cisco CallManager:

• Click No.
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Figure 2-6 Configuring Cisco IP SoftPhone for E911

Step 11 In the screen shown in Figure 2-7, choose the Cisco CallManager version you are 
using and click Next.

Figure 2-7 Choosing the Cisco CallManager Version

Step 12 Use one of the following procedures to configure the Local TSP:

For Cisco CallManager 3.1(x):

a. Enter your username and password in the Local TSP Configuration screen.
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Note The username and password you configure for 
Cisco IP SoftPhone must be exactly the same as the username and 
password assigned to you on the Cisco CallManager. 

b. If you are not using customization files, enter the primary and backup CTI 
Manager IP addresses for the Cisco CallManager.

For Cisco CallManager 3.0(x):

a. Enter your username and password in the Local TSP Configuration screen.

Note The username and password you configure for 
Cisco IP SoftPhone must be exactly the same as the username and 
password assigned to you on the Cisco CallManager. 

b. If you are not using customization files, enter the IP address for the 
Cisco CallManager.

Step 13 Click Next.

Step 14 Select a Program folder to which you want the Installer to add icons.

By default, the Installer adds icons to a folder called Cisco IP SoftPhone.

Step 15 Follow the instructions on the screen.

Step 16 In the Install Wizard Complete dialog window, choose whether you want to 
restart your computer now or later, and click Finish to complete the installation.

You must restart your computer before you can begin using Cisco IP SoftPhone.

Starting Cisco IP SoftPhone
Procedure

Step 1 From the Windows Start menu, choose Programs > Cisco IP SoftPhone > 
Cisco IP SoftPhone.
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The first time you start Cisco IP SoftPhone, the Microsoft NetMeeting 
configuration program may display a window followed by the Cisco IP SoftPhone 
Line Selection window. See Figure 2-8. On subsequent sessions, the main dialing 
window will open.

Step 2 In the Microsoft NetMeeting configuration window, follow the instructions on the 
screen to tune audio parameters and specify user information for your system.

Note You will not see this window if you have previously configured 
Microsoft NetMeeting.

Caution The collaboration features of Cisco IP SoftPhone will not work unless you 
configure settings for Microsoft NetMeeting.

Step 3 In the select lines window, click on the line(s) you want to control and click OK.

Note If there are no lines displayed in the line selection window, refer to the 
“Selecting Lines to Control” section on page 3-2.
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Figure 2-8 Cisco IP SoftPhone Line Selection Window

Related Topics

• Exiting Cisco IP SoftPhone, page 2-13

• Selecting Lines to Control, page 3-2

• Selecting Your Cisco IP Phone Line, page 3-3

• When I Start Cisco IP SoftPhone, Why Don’t I See Any Lines to Control?, 
page A-2

Exiting Cisco IP SoftPhone
To exit Cisco IP SoftPhone, use one of the following procedures:

• Click your right mouse button and select Exit from the floating menu.

• Click the x in the upper right corner of the main dialing window.

• Press the ALT-F4 on your keyboard.

45
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Using Cisco IP SoftPhone

The following sections describe how to use the Cisco IP SoftPhone application to 
place, receive, and control calls from your PC:

• Selecting Lines to Control, page 3-2

• Using the Main Dialing Window, page 3-4

• Placing a Call, page 3-14

• Ending a Call, page 3-17

• Answering a Call, page 3-17

• Placing a Call on Hold, page 3-20

• Transferring a Call, page 3-21

• Using Voice Mail, page 3-22

• Starting an Audio Conference, page 3-25

• Playing .wav Files with Cisco IP SoftPhone, page 3-27

• Using the Dialing Directories, page 3-28

• Viewing Call History, page 3-32

• Configuring Advanced Settings, page 3-33
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Selecting Lines to Control
Use this procedure to select the lines your system administrator has assigned to 
you on the Cisco CallManager. Figure 3-1 illustrates an example of entries in the 
SoftPhone Line Selection window.

Procedure

Step 1 Click the Settings toolbar icon.

Step 2 Click the Advanced tab in the Settings dialog window.

Step 3 Click Select Lines... on the Advanced tab.

Step 4 Select the line(s) you want to control in the line selection dialog window.

Each line that you select must have a unique phone number. You cannot control 
multiple lines that share the same phone number.

Note If there are no lines displayed in the line selection window, see “When 
I Start Cisco IP SoftPhone, Why Don’t I See Any Lines to Control?” 
section on page A-2.

Step 5 Close the Settings dialog window.

When the lines connect, the main dialing window is displayed.

Related Topics

• Using Cisco IP SoftPhone as a Stand-alone Phone, page 1-2

• Using Cisco IP SoftPhone to Control a Cisco IP Phone, page 1-3

• Selecting Your Cisco IP Phone Line, page 3-3

• Line Buttons, page 3-10

• Frequently Asked Questions (FAQs), page A-1
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Figure 3-1 Selecting Lines to Control

Selecting Your Cisco IP Phone Line
If you have multiple lines configured for you on the Cisco CallManager, you may 
see two types of entries in the Select Lines window:

• An entry with the device name and extension assigned to your Cisco IP Phone 
or Cisco IP SoftPhone. For example:

Cisco Line: [CTIPJChamber][52222]

• An entry with the Media Access Control (MAC) address and extension 
assigned to your Cisco IP Phone. For example:

Cisco Line: [SEP003049C2B80F][52222]

1 Select this line to use Cisco IP SoftPhone to control your Cisco IP Phone.

2 Select these lines to use Cisco IP SoftPhone as a stand-alone phone.
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To use Cisco IP SoftPhone as a stand-alone phone, select the entry that contains 
the device name assigned to your Cisco IP Phone or Cisco IP SoftPhone.

To use Cisco IP SoftPhone in tandem with your Cisco IP Phone, select the entry 
that contains the MAC address for your Cisco IP Phone.

Note If you have multiple lines with the same extension configured for you on the 
Cisco CallManager, you can only control one of those lines at a time with 
Cisco IP SoftPhone.

Related Topics

• Using Cisco IP SoftPhone as a Stand-alone Phone, page 1-2

• Using Cisco IP SoftPhone to Control a Cisco IP Phone, page 1-3

• Selecting Lines to Control, page 3-2

• Line Buttons, page 3-10

• Why Does the Audio Sound Jittery and Broken?, page A-8

Using the Main Dialing Window
The main dialing window, shown in Figure 3-2, contains call blocks, icons, and 
buttons for answering, placing, and controlling calls. 

Table 3-1 defines components of the main dialing window. These sections 
describe how to use the controls in the main dialing window:

• Icon Bar, page 3-7

• Context-Sensitive Button Bar, page 3-8

• Line Buttons, page 3-10

• Volume Controls, page 3-11
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Figure 3-2 Main Dialing Window (lines selected)

Table 3-1 Main Dialing Window Components

Component Description

1 Handset Click the handset to go off-hook, depending on the current call state.

2

Dialing box This is where you enter phone numbers when placing a call.

See “Placing a Call” section on page 3-14 for details on how to use the dialing 
box.

3

Exit button Click this button to close the main dialing window and exit 
Cisco IP SoftPhone.

See “Exiting Cisco IP SoftPhone” section on page 2-13 for more details.
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4

Icon bar Click these icons to access your voice mailbox, dialing directories, 
configuration settings, call log, Virtual Conference Room, keypad, volume 
controls, and online help.

See “Icon Bar” section on page 3-7 for more details.

5

Line buttons Click these buttons to select a line when placing a call. The line buttons display 
the phone numbers you are currently controlling with Cisco IP SoftPhone. 

See “Line Buttons” section on page 3-10 for details on how to use the line 
buttons.

6

Call block Displays the call destination, length of call (in hh:mm:ss format) and call 
status for all calls.

See “Viewing Call History” section on page 3-32 for more details.

7

Context-sensitive 
button bar

Click these buttons to access call control functions that are relevant to the 
current call state.

See “Context-Sensitive Button Bar” section on page 3-8 for more details.

8

Speaker volume 
control

Drag the slider on this volume control to increase or decrease the volume of 
your speakerphone.

See “Adjusting the Speaker Volume” section on page 3-12 for more details.

9

Dialing pad 
button

Click this button to hide or display the online dialing pad.

See “Placing a Call” section on page 3-14 for more details.

10
Play messages 
button

Click this icon to plays voice mail for the currently selected line.

11

Microphone 
volume control

Drag the slider on this volume control to increase or decrease the volume of 
your headset microphone.

See “Adjusting the Microphone Volume” section on page 3-13 for more 
details.

12

Microphone mute 
button or icon

Click this button to mute the microphone, preventing the person you are 
speaking to from hearing what you are saying.

See “Adjusting the Microphone Volume” section on page 3-13 for more 
details.

Table 3-1 Main Dialing Window Components (continued)

Component Description
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Icon Bar
Table 3-2 describes the icons in the Cisco IP SoftPhone icon bar.

13

Online dialing 
pad

Click the buttons in the online dialing pad to dial telephone numbers.

See “Dialing from the Online Keypad” section on page 3-15 for more details.

14

Handset button Click this button to hide or display the handset image.

See “Icon Bar” section on page 3-7 for more details.

Table 3-1 Main Dialing Window Components (continued)

Component Description

Table 3-2 Cisco IP SoftPhone Icons

Icon Description

Voice Messages icon. Turns red when you have a voice mail 
message. Also provides access your voice mailbox.

See “Using Voice Mail” section on page 3-22 for more details.

Dialing Directories icon. Displays the dialing directories available 
for use with Cisco IP SoftPhone.

See “Using the Dialing Directories” section on page 3-28 for more 
details.

Settings icon. Displays the Settings dialog window for selecting 
lines, editing the dialing directories and changing collaboration 
settings.

See “Configuring Advanced Settings” section on page 3-33 for 
more details.

Collaboration icon. Invokes a desktop collaboration session using 
Virtual Conference Room.

See Chapter 4, “Collaborating with Virtual Conference Room” for 
more details.
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Context-Sensitive Button Bar
The context-sensitive button bar and button names change, depending on the 
current call state. 

Table 3-3 describes the buttons in the context-sensitive button bar.

Call Log icon. Displays the Call Log showing a history of the calls 
you have placed or received.

See “Viewing Call History” section on page 3-32 for more details.

Keypad icon. Displays/hides the online keypad for dialing phone 
numbers.

See “Dialing from the Online Keypad” section on page 3-15 for 
more details.

Volume Settings icon. Displays controls for adjusting the speaker, 
microphone, ring, and wave file volume.

See the “Volume Controls” section on page 3-11 for more details

Help icon. Displays the online help system for Cisco IP SoftPhone.

Table 3-2 Cisco IP SoftPhone Icons (continued)

Icon Description

Table 3-3 Context-Sensitive Button Bar

Button Button Name Call State Description

Off Hook or 
Answer

Idle or 
incoming call

Click this button to start or answer a call. It 
performs the same function as lifting the 
receiver on a telephone.

End Call In a call Click this button to end or “hang up” a call.
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Dial Idle Click this button to dial the number entered 
in the dialing box. 

Redial Idle/off-hook Click this button to redial the most recently 
dialed number.

Clear Idle Click this button to clear the entry in the 
dialing box. 

Hold or 
Resume

In a call or 
call hold

Click this button to place a call on hold or 
take a call off hold.

Transfer or 
Send Call

In a call or 
call transfer

Click this button to begin a call transfer or to 
complete the transfer.

Consult or 
Invite

Call transfer 
or 
Conference 
Call

When transferring a call, click this button to 
place a consultation call to the intended 
recipient. When in a conference call, click 
this button to add a party to the call.

Cancel Outgoing call Click this button to cancel an outgoing call, 
call transfer or conference call before it 
connects.

Conference In a call Click this button to initiate a conference call.

Join Conference 
call

Click this button to add a party to a 
conference call.

Deflect Incoming call When click this button to deflect an 
incoming call to another number without 
interacting with the caller.

Table 3-3 Context-Sensitive Button Bar (continued)

Button Button Name Call State Description
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Line Buttons
The line buttons in the main dialing window display the phone numbers of the 
lines you are currently controlling with Cisco IP SoftPhone. Lines that are 
terminated by a Cisco IP Phone device display a phone icon; lines that are 
terminated by your computer (e.g., stand-alone phone mode) display a PC icon. If 
you have multiple phone lines assigned to you, press a line button to select the line 
you want to use for outgoing calls. 

If the call arrives on a line other than the selected line, the focus will automatically 
change to the incoming call. To accept the call, click the Answer button. You can 
also accept the call on a Cisco IP Phone by lifting the handset and pressing the 
appropriate line button.

Changing the Display
When you first start the Cisco IP SoftPhone, the main dialing window appears in 
the full-view mode. The full-view mode includes a handset image and dialing pad 
to provide the familiar look and feel of a telephone. However, you do not need to 
use the handset and keypad to place and receive calls with Cisco IP SoftPhone. 
Once you are familiar with the Cisco IP SoftPhone interface, you can hide these 
features so the main dialing window takes up less space on your desktop.

To hide the handset and/or keypad, click the handset button and/or dialing pad 
button. The main dialing window will then appear as shown in Figure 3-3.

Voice mail Incoming call Click this button to automatically send an 
incoming call to voice mail without 
interacting with the caller.

Ignore Incoming call Click this button to ignore an incoming call. 
The call will automatically disconnect 
without interacting with the caller.

Table 3-3 Context-Sensitive Button Bar (continued)

Button Button Name Call State Description
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Figure 3-3 Main Dialing Window (minimized)

Tip You can keep Cisco IP SoftPhone running in the background in a minimized 
state and open it whenever you want by clicking the telephone icon in the 
lower right corner of your Windows desktop. You can continue to work on 
other applications while making calls or while answering incoming calls.

Volume Controls
The speaker and microphone controls in the main dialing window adjust the 
volume of the currently active voice receiver: the computer headset, computer 
handset, or the computer speaker. You can also use the volume settings icon in the 
icon bar to adjust these settings, as well as to adjust the ring and .wav file volume.
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Note The volume controls adjust the volume only if you are using 
Cisco IP SoftPhone. If you are using Cisco IP SoftPhone to control an IP 
phone, you will need to use the ringer, speakerphone and handset volume 
controls on the Cisco IP Phone base to adjust the volume.

Related Topics

• Using Cisco IP SoftPhone as a Stand-alone Phone, page 1-2

• Using Cisco IP SoftPhone to Control a Cisco IP Phone, page 1-3

• Adjusting the Speaker Volume, page 3-12

• Adjusting the Microphone Volume, page 3-13

Adjusting the Speaker Volume

If you are in full-view mode, use your mouse to drag the speaker volume controls 
to set the desired volume.

If you are not in full-view mode, click the volume control icon in the icon bar to 
access the volume controls. See Figure 3-4. Use your mouse to drag the volume 
bars up and down to set the desired volume.

To mute the speaker, click the Mute checkbox beneath the speaker volume control. 

Table 3-4 defines the volume controls.

Figure 3-4 Volume Control dialog window
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Adjusting the Microphone Volume

Use your mouse to drag the microphone volume controls to set the desired input 
sensitivity (volume) of the computer microphone or headset microphone. To mute 
the microphone, click the Mute button or icon. To locate the Mute button or icon, 
see Table 3-5. The button and icon will turn red to indicate that the microphone 
is muted. To turn muting off, click the button or icon again.

Table 3-4 Volume Controls

Volume Control Description

Speaker Volume Adjusts the volume of the computer speaker. Enable 
the checkbox below this column to mute the computer 
speaker.

Microphone Volume Adjusts the input sensitivity (volume) of the computer 
microphone. Enable the checkbox below this column 
to mute the computer microphone.

Ring Volume Adjusts the ring volume of the output .wav file. Enable 
the checkbox below this column to mute the ring 
volume.

Wave File Volume Adjusts the volume of .wav files played through 
Cisco IP SoftPhone.

Table 3-5 Mute button and icon

Button Location

In full-view mode, this Mute button is located below the Play 
messages button.

This Mute icon is located to the left of the Dialing pad button.
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You can adjust also the microphone volume using the volume settings icon. Click 
the volume settings icon in the icon bar to access the volume controls. See 
Figure 3-4. Use your mouse to drag the microphone volume bar up and down to 
set the desired volume. To mute the microphone, click the Mute checkbox beneath 
the microphone volume control. 

Placing a Call
Procedure

Step 1 In the main dialing window, click the line button for the line you want to use.

The call block for that line displays.

Step 2 Dial the number you want to call in one of the following ways:

• Use your keyboard to type the number in the dialing box and press Enter.

• Enter the e-mail address or name (partial or full) for the person you want to 
call and press CTRL-K.

– To use this feature, you must have a directory entry for the recipient that 
includes their e-mail address and phone number.

• Use your mouse to click the keys on the online keypad and click Dial.

See the “Dialing from the Online Keypad” section on page 3-15 for more 
details.

• Drag the number from your Internet browser into the dialing box.

• Open a Cisco IP SoftPhone directory, click your mouse on the name of the 
person you want to dial and click Dial.

See the “Dialing from the Online Directories” section on page 3-16 for more 
information.

• Click on the arrow next to the dialing box, select the number from the list of 
recently dialed numbers, and click Dial.

See the “Dialing the Last Number Dialed” section on page 3-17 for more 
details.

• Drag the number from the Cisco IP SoftPhone dialing directory to the dialing 
box.
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• Copy the number from any Windows program, paste it into the dialing box, 
and click Dial.

• Drag a v-card file from your desktop into the dialing box.

When the call connects, the context-sensitive button bar displays buttons that 
enable you to perform additional call functions. See Figure 3-5.

Figure 3-5 Calling Options

Related Topics

• Dialing from the Online Keypad, page 3-15

• Dialing from the Online Directories, page 3-16

• Dialing the Last Number Dialed, page 3-17

• Ending a Call, page 3-17

• Placing a Call on Hold, page 3-20

• Transferring a Call, page 3-21

• Starting an Audio Conference, page 3-25

Dialing from the Online Keypad
To provide the familiar look and function of a telephone keypad, 
Cisco IP SoftPhone includes an online keypad for dialing calls. Simply click your 
mouse on the numbers you want to dial and then click the Dial button. Use of the 
online keypad is optional.

1 Hold 2 Transfer 3 Conference 4 End Call
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Procedure

Step 1 In the main dialing window, click the line button for the line you want to use.

Step 2 Click the Off Hook button or click on the handset image.

Step 3 If the online keypad is not open, click the keypad icon in the icon bar.

Step 4 Click on the telephone number digits in the keypad.

The call will automatically connect once you enter the digits.

Dialing from the Online Directories
With Cisco IP SoftPhone, you can focus on names rather than numbers by placing 
calls through your public and personal online directories.

Procedure

Step 1 Click the Directories icon.

The Directories window opens.

Step 2 Select the desired directory from the drop-down list box.

The directory list displays, showing the name, phone number, and e-mail address 
for each person in the directory.

Tip To narrow the list of names displayed in the directory, enter the first few 
characters of the person’s last name in the find box and then click Find. You 
can also do a search on the person’s name by typing it in the find box and then 
clicking Find.

Step 3 To place a call from the directory, do one of the following:

• Click on the name of the person you want to call and click Dial.

• Drag the name of the person you want to call from the directory to the dialing 
box.
3-16
Cisco IP SoftPhone User Guide

OL-1599-02



 

Chapter 3      Using Cisco IP SoftPhone
Ending a Call
Related Topic

• Using the Dialing Directories, page 3-28

Dialing the Last Number Dialed
Click the Redial button to automatically redial the last number dialed. You can 
also redial a recent number called by choosing it from the destination drop-down 
list box and clicking the Dial button. Cisco IP SoftPhone keeps a list of the last 
15 dialed numbers.

Ending a Call
Click the End Call button to disconnect a call.

If you are using Cisco IP SoftPhone with a Cisco IP Phone, you can also end a 
call by putting the phone on-hook.

Answering a Call
Click the Answer button to answer an incoming call.

Additionally, if you are using Cisco IP SoftPhone to control a Cisco IP Phone, 
you can answer an incoming call simply by picking up the handset or by using any 
answering method supported by the physical phone.

When you have an incoming call, the context-sensitive button bar displays buttons 
that enable you to answer, deflect, send the call to voice mail, or ignore the call. 
See Figure 3-6. You can also configure Cisco IP SoftPhone to automatically 
answer the phone. See the “Automatically Answering a Call” section on 
page 3-19 for more details.

If you receive an incoming call while you are already in a call, click the Answer 
button to place the current call on hold and answer the incoming call. Otherwise, 
use any of the other calling options that are presented to you on the 
context-sensitive button bar to handle the incoming call.
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Figure 3-6 Answering a Call Options

Related Topics

• Automatically Answering a Call, page 3-19

• Deflecting an Incoming Call, page 3-18

• Sending an Incoming Call to Voice Mail, page 3-18

• Ignoring an Incoming Call, page 3-19

Deflecting an Incoming Call
Click the Deflect button to send an incoming call to another number without 
interacting with the caller. The cursor will move to the dialing box, allowing you 
to type the number to which you want to deflect the call. Press the Send Call 
button on the Cisco IP SoftPhone, or Enter on your computer keyboard after you 
type the number.

You can also deflect an incoming call by dragging the number to which you want 
to deflect the call from the directory to the dialing box.

Sending an Incoming Call to Voice Mail
Click the Voice mail button in the context-sensitive button bar to automatically 
send an incoming call to voice mail without interacting with the caller. If you have 
not configured a voice mail destination through the Settings menu for 
Cisco IP SoftPhone, you will be prompted to enter the voice mail box destination. 
See Figure 3-7.

1 Answer 2 Deflect 3 Voice mail 4 Ignore
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Figure 3-7 Deflecting an Incoming Call to Voice mail

Related Topic

• Using Voice Mail, page 3-22

Ignoring an Incoming Call
Click the Ignore button in the context-sensitive button bar to automatically send 
an incoming call to voice mail without interacting with the caller.

Automatically Answering a Call
Use this procedure to configure Cisco IP SoftPhone to automatically answer 
incoming calls and play a .wav file to the caller. 

Procedure

Step 1 Click the Settings toolbar icon.

This opens the Settings dialog window.

Step 2 On the Call Control tab, enable the checkbox next to “Answer Calls 
Automatically,” and enter the number of rings you want the caller to hear before 
the call is answered.

By default, the number of rings is set to one.

Step 3 Enable the checkbox next to “Enable Automatic Greeting.”

Step 4 In the Greeting File... selection box, enter the pathname for the .wav file you want 
to play as your greeting.

The .wav file needs to be formatted as 16-bit, 8KHz PCM (Mono).
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Tip Use the Windows Sound Recorder to record a .wav file or to verify if a .wav 
file is the proper format. You can also use the Windows Sound Recorder to 
convert a .wav file to the proper format. See the online help for the Sound 
Recorder program for details.

Step 5 Click OK to save your settings and close the Settings dialog window.

Figure 3-8 Automatic Greeting Settings

Related Topic

• Using Auto-Greet Mode, page 3-27

Placing a Call on Hold
To place an active call on hold, click the Hold button in the context-sensitive 
button bar, or if you are controlling a Cisco IP Phone, the Hold button on the 
phone base.
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While the call is on hold, caller information, and the time on hold will be 
displayed in the call block.

To retrieve a call on hold, press the Resume button in the context-sensitive button 
bar, or the Resume key on the Cisco IP Phone.

To place an active call on hold so you can receive an incoming call, click the 
Answer button.

Transferring a Call
Call transfer allows you to send an existing call to an internal or external 
extension.

These sections describe two ways you can transfer a call with Cisco IP SoftPhone:

• Performing a Consult Transfer, page 3-21

• Performing a Direct Transfer, page 3-22

Performing a Consult Transfer
In a consult transfer, also called an attended transfer, you place a consultation call 
to the intended recipient before you transfer the call.

Procedure

Step 1 During an active call, click the Transfer button in the context-sensitive button bar 
or if you are controlling a Cisco IP Phone, the Transfer key on the phone base.

Step 2 In the dialing box, enter the new destination.

Step 3 Press Consult and announce the call to the new destination.

Step 4 Press Send Call.

When the transfer is complete, both the original and the consultation call are 
removed from your screen.
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Performing a Direct Transfer
In a direct transfer, also called an unattended transfer, you immediately transfer 
the original call to the destination without a consultation call. 

Procedure

Step 1 During an active call, click the Transfer button in the context-sensitive button 
bar, or if you are controlling a Cisco IP Phone, the Transfer key on the phone 
base.

This opens a transfer dialing box.

Step 2 In the transfer dialing box, enter the new destination

Step 3 Press Enter on the keyboard or click Send Call to complete the transfer.

When the transfer is complete, both the original and the consultation call are 
removed from your screen.

Using Voice Mail
These sections help you use the voice mail features of Cisco IP SoftPhone:

• Configuring Your Voice Mailbox, page 3-22

• Checking Voice Mail, page 3-23

• Forwarding All Calls to Voice Mail, page 3-24

Configuring Your Voice Mailbox
Before you can access your voice mail with Cisco IP SoftPhone, you will need to 
configure the number for your voice mailbox.

Procedure

Step 1 Click the Settings toolbar icon.
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This opens the Call Control tab.

Step 2 Enter the number for your voice mailbox in the Voice mail Destination box.

Step 3 Click OK.

Related Topics

• Voice Mail Integration, page 1-9

• Checking Voice Mail, page 3-23

• Forwarding All Calls to Voice Mail, page 3-24

Checking Voice Mail
When you have a voice mail message, the messages icon in the icon bar turns red 
until you check your messages as follows:

Prerequisite

• Configure the number to access your voice mailbox. See “Configuring Your 
Voice Mailbox” section on page 3-22.

Procedure

Step 1 Click the voice mail message icon.

A pop-up dialog box will appear with the lines which have voice mail.

Step 2 Select the line for which you want to check voice mail.

Cisco IP SoftPhone will automatically dial your voice mailbox.

Step 3 Follow the voice prompts to access your voice mail.

Tip To quickly check voice mail for a selected line, click the Play Messages button 
in the main dialing window.
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Related Topics

• Voice Mail Integration, page 1-9

• Configuring Your Voice Mailbox, page 3-22

Forwarding All Calls to Voice Mail
Use this procedure to automatically forward all calls to voice mail.

Prerequisite

• Configure the number to access your voice mailbox. See “Configuring Your 
Voice Mailbox” section on page 3-22

Procedure

Step 1 Click the Settings toolbar icon.

This opens the Call Control tab.

Step 2 Enable Forward All Incoming Calls to Voice mail checkbox.

Step 3 Click OK.

To remove call forward:

Step 1 Uncheck the Forward all incoming calls to Voice Mail checkbox on the Call 
Control tab.

Step 2 Click OK.

Related Topics

• Voice Mail Integration, page 1-9

• Configuring Your Voice Mailbox, page 3-22

• Checking Voice Mail, page 3-23
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Starting an Audio Conference
You set up audio conference calls with Cisco IP SoftPhone using the Conference 
button in the context-sensitive button bar, or by dragging a directory entry onto 
the call block of an active call. The name of each user who has agreed to join the 
conference will appear in the Cisco IP SoftPhone roster display.

Procedure

Step 1 Place a call to the first conference call destination.

Step 2 Once you have established a connection, click the Conference button in the 
context-sensitive button bar

Step 3 In the dialing box, enter the second conference call destination.

Tip You can drag conference call destinations from your personal and public 
dialing directories into the dialing box.

Step 4 Click Invite or press Enter.

Step 5 Click Join to set up a three-way conference between yourself, the first 
destination, and the second destination

Repeat steps 3 through 5 to add additional participants to the conference. A 
maximum of six participants are allowed in an audio conference.

Related Topics

• Audio Conferencing, page 1-5

• Desktop Collaboration with Virtual Conference Room, page 1-6

• Adding Participants to a Conference, page 3-26

• Leaving a Conference, page 3-26

• Using the Roster, page 4-2
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Adding Participants to a Conference
You may add participants to an audio conference call at any time, even while a 
collaboration session is in progress. The new participant will join both the audio 
and data portions of the conference. The most current data from the collaboration 
session will be displayed on the new participant’s PC. A maximum of six 
participants are allowed in any given conference.

Procedure

Step 1 Start an audio conference.

See “Starting an Audio Conference” section on page 3-25

Step 2 Enter the destination you want to add to the conference call in the dialing box.

Tip You can drag conference call destinations from your personal and public 
dialing directories into the dialing box.

Step 3 Click Invite or press Enter.

Step 4 Click Join to add this person to the conference.

When the audio conference call is active, the caller ID for each participant will be 
displayed in the main dialing window. A maximum of six participants are allowed 
in any given conference.

Related Topic

• Leaving a Conference, page 3-26

Leaving a Conference
You can leave an audio conference at any time by clicking the End Call button in 
the context-sensitive button bar. When you exit from an audio conference, 
Cisco IP SoftPhone removes your name from the roster.
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Playing .wav Files with Cisco IP SoftPhone
When you use the Cisco IP SoftPhone as an online IP phone, you can play 
pre-recorded audio files (.wav) files to callers in the form of a customized greeting 
or during the course of a call. The Cisco IP SoftPhone supports .wav files that are 
formatted as 16-bit, 8KHz PCM (Mono). You can use the Microsoft Windows 
Sound Recorder application to create files in this format or convert other .wav 
files to this format.

These sections help you play .wav files with Cisco IP SoftPhone:

• Using Auto-Greet Mode, page 3-27

• Playing a .wav File to a Caller, page 3-28

• Stopping a .wav File During a Call, page 3-28

Using Auto-Greet Mode
You can configure Cisco IP SoftPhone to automatically play a predetermined 
.wav file to the caller when a call is answered.

Step 1 Click the Settings toolbar icon.

This opens the Call Control tab.

Step 2 Enable the Enable Automatic Greeting checkbox.

Step 3 In the Greeting File... selection box, enter the pathname for the .wav file you want 
to play as your greeting, or click Browse... to find and select the file.

The .wav file needs to be formatted as 16-bit, 8KHz PCM (Mono).

Step 4 Click OK.

Related Topic

• Automatically Answering a Call, page 3-19
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Playing a .wav File to a Caller
If you are using Cisco IP SoftPhone as a stand-alone application, you can play a 
.wav file to the caller at any time during the course of the call. The .wav file is 
also played simultaneously on your PC. Only one file may be played at a time.

Procedure

Step 1 Right-click your mouse in the main dialing window.

Step 2 Choose Play File... from the floating menu.

Step 3 In the filename box, enter the path and name of the .wav file you want to play.

The .wav file needs to be formatted as 16-bit, 8KHz PCM (Mono).

Step 4 Click Open.

The .wav file will be played to the caller.

Related Topics

• Volume Controls, page 3-11

• Stopping a .wav File During a Call, page 3-28

Stopping a .wav File During a Call
To stop a .wav file you are playing to a caller, click Stop Playing Wave File from 
the Cisco IP SoftPhone floating menu.

Using the Dialing Directories
Cisco IP SoftPhone integrates with the directory service that is installed on the 
Cisco CallManager. The name of this directory is set by your system 
administrator when configuring your network for Cisco IP SoftPhone.
3-28
Cisco IP SoftPhone User Guide

OL-1599-02



 

Chapter 3      Using Cisco IP SoftPhone
Using the Dialing Directories
Additionally, the Cisco IP SoftPhone provides a personal directory for you to 
store directory entries that are not available in the corporate or public directories. 
Cisco IP SoftPhone always searches your personal directory first before looking 
up an entry in the public directories. It also integrates with other private 
directories like those implemented by the various email clients.

These sections help you configure and use the dialing directories:

• Dialing from the Online Directories, page 3-16

• Adding a Directory Entry, page 3-29

• Deleting a Directory Entry, page 3-31

• Editing a Directory Entry, page 3-32

• Searching for a Directory Entry, page 3-32

Adding a Directory Entry
You can add entries to your personal directory by dragging an active call into the 
directory or adding the address through the Add/Edit Directory Entry dialog 
window.

Tip To collaborate with others, you need to add an entry for yourself to your 
personal directory. Be sure to specify the host name or IP address of your 
computer in the “Associated PC” field.

Procedure

Step 1 Click the Directories toolbar icon.

Step 2 Click the Add Directory Entry button to open the Add/Edit Directory Entry 
dialog window.

Step 3 Enter address information in the entry boxes in one of the following ways:

• Use your keyboard to type the address information.

Figure 3-9 illustrates the entries in the Add/Edit Directory Entry dialog 
window.
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• Drag a v-card file from your web browser into the Add/Edit Directories 
dialog window. Cisco IP SoftPhone will display a prompt asking whether you 
want to add this destination to the address book.

• Drag an entry from your Public directory to your Personal directory.

Step 4 When you are finished, click OK.

The name, number, and e-mail address you entered will now appear in the 
Directories dialog window. To dial that person, simply select the directory entry 
and click Dial.

Figure 3-9 Adding/Editing an Address Book Entry

Related Topics

• Dialing from the Online Directories, page 3-16

• Using the Dialing Directories, page 3-28

1
IP address or host name of person’s PC. You must specify this information 
to collaborate with this person.
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• Deleting a Directory Entry, page 3-31

• Editing a Directory Entry, page 3-32

Deleting a Directory Entry
Use this procedure to delete names from your personal directory.

Note You cannot delete names from a public directory.

Procedure

Step 1 Click the Directories toolbar icon.

Step 2 Select the Personal directory name from the drop-down list box.

Step 3 Select the entry you want to delete.

Step 4 Click the Remove Directory Entry button.

A confirmation dialog window will display asking you to confirm whether you 
want to delete this person from the directory.

Step 5 Click Yes to confirm the deletion.

The entry will be removed from the Directories dialog window.

Related Topics

• Dialing from the Online Directories, page 3-16

• Using the Dialing Directories, page 3-28

• Adding a Directory Entry, page 3-29

• Editing a Directory Entry, page 3-32
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Editing a Directory Entry
Use this procedure to edit directory entries in your Personal directory.

Procedure

Step 1 Click the Directories toolbar icon.

Step 2 Select the Personal directory name from the drop-down list box.

Step 3 Double-click on the directory entry you want to edit, or select it with your mouse 
and then click the Edit Directory Entry button.

This opens the Add/Edit Directory Entry dialog window.

Step 4 Make the desired changes to the address information.

Step 5 Click OK to enable your changes.

Related Topics

• Adding a Directory Entry, page 3-29

• Deleting a Directory Entry, page 3-31

• Using the Dialing Directories, page 3-28

• Dialing from the Online Directories, page 3-16

Searching for a Directory Entry
You can use the filter box to narrow the list of names displayed in the directory. 
Type the first few characters of the name of the person you want to call, and click 
the Find button.

Viewing Call History
Click the Call Log icon in the icon bar to display a history of the calls you have 
placed or received. See Figure 3-10.

Table 3-6 defines the information stored in the Call Log.
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Figure 3-10 Calls Log dialog window

Configuring Advanced Settings
Use the Advanced tab in the Settings dialog window to perform the following 
tasks:

• Configure the name of the Cisco CallManager server you are using (for 
remote TSP only).

• Select the lines you want to control. 

Table 3-6 Calls Log Data

Field Description

1 Line Line which handled the call

2 Start Time Date and time the call connected

3 Direction Whether the call was an incoming call or an outgoing call

4 Other Party The phone number of the connected party

5 End Time Time the call ended

1 2 3 4 5
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• Change the collaboration settings

• Change the language settings.

Procedure

Step 1 Click the Settings toolbar icon.

Step 2 Select the Advanced tab.

See Figure 3-11.

Step 3 Configure the settings described in Table 3-7.

Step 4 Click OK.

Note If you are running Windows NT 4.0 and you have dial-up networking 
configured, you will need to reboot your PC for the remote TAPI server 
settings to take effect.

Figure 3-11 Advanced tab
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Table 3-7 Configuring Advanced Setting s

Setting Description

1

Server Name If you are using remote TSP to communicate with the 
Cisco CallManager, disable the local TSP checkbox and enter 
the hostname of the remote TSP server you are using here.1

1. Using remote TSP to communicate with the Cisco CallManager is not a supported configuration for Cisco IP SoftPhone.

2

Local TSP checkbox Enable this checkbox if you are using local TSP to 
communicate with the Cisco CallManager (default). Disable 
this checkbox if you are using remote TSP.

3

Collaboration Setting Enable the Virtual Conference Room option to use the 
collaboration features of Cisco IP SoftPhone. Enable the 
NetMeeting option to use the video collaboration features of 
Microsoft NetMeeting. You must restart your computer to make 
these changes take effect.

4
Languages Choose the language in which you want to run 

Cisco IP SoftPhone.

5

Select Lines Click Select Lines... to select the IP phone line(s) you want to 
control.

See “Selecting Lines to Control” section on page 3-2 for more 
details.
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Collaborating with Virtual Conference 
Room

These sections help you understand and use the Virtual Conference Room desktop 
collaboration features of Cisco IP SoftPhone:

• Collaboration Checklist, page 4-1

• Using the Roster, page 4-2

• Using the Application Sharing Window, page 4-4

• Starting a Whiteboard Session, page 4-10

• Sending a Chat Message, page 4-12

• Preparing for a Video Collaboration Session, page 4-13

Collaboration Checklist
Before you begin a collaboration session, verify the settings in Table 4-1.

Note The collaboration features of Cisco IP SoftPhone will not work unless you 
configure settings for NetMeeting. See “Diagnosing Problems with 
Collaboration” section on page A-18 for details on how to configure settings 
for NetMeeting.
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Using the Roster
When you click the Collaboration icon while in a call or audio conference, 
Cisco IP SoftPhone displays a roster window on your computer screen. The roster 
shows a list of the participants in the call. It updates this list as participants join 

Table 4-1 Collaboration Checklist

Setting Description

Collaboration Open the Settings window and verify that “Virtual 
Conference Room” is selected for the 
Collaboration Setting on the Advanced tab.

Associated PC Open your personal or public directory and verify 
that the correct host name or IP address is 
specified for the “Associated PC” entry for all 
participants in the collaboration session, 
including yourself. If the “Associated PC” is not 
specified or incorrect for a participant, you will 
need to add or update the entry in your personal 
directory, or contact your system administrator to 
update the public directory. When setting up a 
collaboration session, Cisco IP SoftPhone first 
looks for the participants in your personal 
directory. If it does not find an entry, it then looks 
in the public directory.

Microsoft NetMeeting If you have upgraded your NetMeeting 
installation (version 3.01 or greater) since 
installing Cisco IP SoftPhone, be sure to tune 
your audio settings and configure user settings for 
NetMeeting.

NetMeeting version 3.01 gets installed as part of 
the Cisco IP SoftPhone installation. You typically 
tune your audio settings and configure user 
settings for NetMeeting the very first time you run 
Cisco IP SoftPhone.
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and exit the conference. The roster includes icons you can click to share a 
whiteboard, application, or document, or start a chat session with other 
participants in the call. See Figure 4-1.

If participants are able to collaborate, the icon next to their name in the roster 
window will be highlighted in green.

Tip If a participant’s name is not highlighted in green on the roster, use the 
collaboration checklist to verify that all collaboration conditions are met. See 
the “Collaboration Checklist” section on page 4-1 for details.

Figure 4-1 Roster window

Related Topics

• Desktop Collaboration with Virtual Conference Room, page 1-6

• Collaboration Checklist, page 4-1

• Using the Application Sharing Window, page 4-4

• Starting a Document Sharing Session, page 4-5

• Starting a Whiteboard Session, page 4-10

• Sending a Chat Message, page 4-12
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Using the Application Sharing Window
The Applications List button in the roster window displays a list of the 
applications and files you currently have open on your machine. Click this button 
to initiate a data collaboration session or to collapse/expand the application 
window.

Figure 4-2 shows how to use the Application Sharing window. Table 4-2 
describes the application sharing controls in the button bar.

Figure 4-2 Application Sharing window

1 Click here to start a whiteboarding session.

2 Click here to start a chat session.

3
Click here to initiate a collaboration session or expand/collapse the 
application window.

4 Drag a file into the roster window to share with other participants.
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Related Topics

• Collaboration Checklist, page 4-1

• Using the Roster, page 4-2

• Starting a Document Sharing Session, page 4-5

• Transferring Control of a Document, page 4-7

• Requesting Control of a Document, page 4-9

• Ending a Document Sharing Session, page 4-9

Starting a Document Sharing Session
When you start a document or application sharing session, Cisco IP SoftPhone 
opens a new window on each person’s desktop and displays the file you are 
sharing. Initially, you have control of the file. However, you can transfer control 
to any of the participants, allowing them to make changes even if they don’t have 
the associated application installed on their computers. 

Table 4-2 Application Sharing Controls

Control Description

Refresh button Refreshes the list of applications in the roster window.

Share button Shares the application or file selected in the roster 
window with all participants in the call.

Unshare button Stops sharing the application or file selected in the roster 
window and removes the image from each participant’s 
computer screen.

Browse button Opens the file you choose, adds it to the list of 
applications in the roster window, and shares the 
associated application.

“Allow control of 
shared applications” 
checkbox

Assigns and removes control of shared applications. This 
option is active only when at least two parties in the call 
can collaborate.
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You can share more than one program at a time and several people can share 
programs simultaneously. Also, you can share a whiteboard and document at the 
same time.

Note To do application and document sharing, each participant must be listed in 
your public or personal directory with the correct Associated PC address 
configured. See “Adding a Directory Entry” section on page 3-29 for details.

Procedure

Step 1 While in a call or audio conference, click the Applications List button on the 
roster.

A list of the applications that are currently active on your computer will be 
displayed.

Step 2 Click Browse and choose the file you want to share, or open your Microsoft 
Windows Explorer and drag the file icon into the list of applications in the roster 
window.

Cisco IP SoftPhone will open the file and associated application on your desktop 
and add it to the list of active applications in the roster.

Step 3 Select the file from the list of applications in the roster and click Share.

The file will be displayed in a new window on each participants’ computer screen, 
regardless of whether they have the associated application installed.

Initially, you have control of the file. However, you can allow transfer of control 
at any time. See the “Transferring Control of a Document” section on page 4-7 for 
details.

Tip You can also share an application or document by dragging it from the 
Windows Explorer into the roster window.
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Caution If you share a Windows Explorer window, such as My Computer, Control 
Panel, or a folder on your computer, you will be sharing all the Explorer 
windows you have open. Also, once you have shared such a window, every 
program you start while you are still in the meeting is automatically shared 
with the other participants. 

Related Topics

• Desktop Collaboration with Virtual Conference Room, page 1-6

• Application and Document Sharing, page 1-7

• Collaboration Checklist, page 4-1

• Using the Application Sharing Window, page 4-4

• Transferring Control of a Document, page 4-7

• Requesting Control of a Document, page 4-9

• Ending a Document Sharing Session, page 4-9

Transferring Control of a Document
While in a document or application sharing session, the person who initially 
shared the document or application has control of the file. This person, called the 
“Top Provider” can transfer control of the file to other participants in the session. 
However, only one person can be in control of a shared program at a time. When 
the Top Provider is allowing others to work on the program, the word 
Controllable appears in the title bar of the shared program window. Participants 
can send a request to the Top Provider asking for control of the file. If the mouse 
pointer has a box with initials, then another meeting participant has control of the 
program.

Note You can only transfer and remove control of a shared file if you are the Top 
Provider.
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Procedure

Step 1 Start a document sharing session.

See “Starting a Document Sharing Session” section on page 4-5.

Step 2 In the roster window, click on the participant to whom you would like to transfer 
control of the document.

Step 3 Click in the checkbox next to “Allow control of shared applications.”

The roster will display “In Control” next to the participant’s name. This person 
will now have control of the file. See Figure 4-3. Controllable will appear in the 
title bar of the shared program window on each participant’s computer screen.

To regain control of a shared application or file, double-click on the application 
being shared.

Figure 4-3 Transferring Control of a Document

1 This person has control of the file.

1
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Related Topics

• Requesting Control of a Document, page 4-9

• Ending a Document Sharing Session, page 4-9

Requesting Control of a Document
If you are participating in a document sharing session, you can request control of 
the document from the Top Provider by double-clicking in the document sharing 
application window, or by choosing Control > Request Control. 
Cisco IP SoftPhone will send a message to the Top Provider asking to accept or 
reject the your request. See Figure 4-4.

If the Top Provider does not respond to your request within 10 seconds, the 
request will fail.

Figure 4-4 Requesting Control of a Document

Ending a Document Sharing Session
To end a document sharing session, select the document in the roster window and 
click Unshare. This will close the document window for the file you are sharing 
and remove the document from each participant’s screen. A document sharing 
session can only be ended by the Top Provider.
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Starting a Whiteboard Session
When you start a whiteboard session, a whiteboard will appear on each 
participant’s computer screen. While in a whiteboard session, any participant can 
use the whiteboard tools to draw structured or free-hand objects on a shared 
screen. You can dismiss the whiteboard by closing it after (optionally) saving its 
contents. When you close the whiteboard, it disappears only from your computer 
screen; other participants can still see and participate in the whiteboard session. 
You can re-enter an active whiteboard session at any time by clicking the 
whiteboard button.

Only one whiteboard session may be open at a time. However, there can be a 
concurrent whiteboard and document sharing session.

Note To do whiteboarding, each participant must be listed in your public or personal 
directory with an entry in the “Associated PC” field. See “Adding a Directory 
Entry” section on page 3-29 for details.

Procedure

Step 1 While in a call or audio conference, click the collaboration icon.

The roster will display showing all the participants in the call.

Step 2 Click the whiteboard icon in the roster.

An empty whiteboard window will display on each particpant’s computer screen.

Step 3 Use the whiteboard tools to illustrate your ideas in the whiteboard window. Each 
meeting participant will see your work without having access to your desktop.

For details on how to use the whiteboard tools, click the help button in the 
whiteboard window to access online help.

If you want to limit control of the whiteboard, see the “Whiteboard 
Synchronization” section on page 4-11.

Related Topics

• Desktop Collaboration with Virtual Conference Room, page 1-6

• Whiteboarding, page 1-6
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• Collaboration Checklist, page 4-1

• Ending a Whiteboard Session, page 4-11

• Whiteboard Synchronization, page 4-11

Ending a Whiteboard Session
To end a whiteboard session, close the whiteboard window after (optionally) 
saving its contents. When you close the whiteboard, it will remain open on each 
participant’s computer screen, allowing them to save its contents on their local 
drive and then close the whiteboard window when they are done. If you leave a 
whiteboard session but remain in the call, you can re-join the whiteboard session 
at any time by clicking the whiteboard button.

Note If you initiate a whiteboard session and exit Cisco IP SoftPhone while other 
participants remain in the whiteboard session, the whiteboard session will 
automatically terminate on each participants’ PC.

Whiteboard Synchronization
Synchronization allows everyone to automatically view the same whiteboard 
page. By default, synchronization is always selected when you first start a 
whiteboard session.

If you want to work on a page privately, you can remove synchronization to stop 
the page from displaying automatically. Synchronization does not affect other 
participant’s views of the current page. If you turn off synchronization and keep 
working on the current page, the other participants can view your actions.

Procedure

Step 1 Start a whiteboard session.

See “Starting a Whiteboard Session” section on page 4-10.

Step 2 On the whiteboard screen, click View > Synchronize.
4-11
Cisco IP SoftPhone User Guide

OL-1599-02



 

Chapter 4      Collaborating with Virtual Conference Room
Sending a Chat Message
This should remove the check mark next to “synchronization” indicating that it is 
not active.

Sending a Chat Message
The roster window includes a chat button which launches the Microsoft 
NetMeeting chat application. Use the chat application to send a message to all or 
selected meeting participants.

When someone sends you a chat message, the message appears in the Chat 
window. See Figure 4-5.

Figure 4-5 Chat Session

For details on how to customize the fonts, information display, and message 
format for the chat application, click the help menu in the chat window.

Procedure

Step 1 While in a call or audio conference, click the collaboration icon.

The roster will display showing all the participants in the call.
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Step 2 Click the Chat button to open the Chat window.

Step 3 In the Message block, type the message you want to send, then do one of the 
following: 

• To send a message to all meeting participants, select Everyone In Chat from 
the Send to drop-down list.

• To send a message to just one person, select the person’s name from the Send 
To drop-down list.

Step 4 Click the Send Message button or press Enter on your keyboard to send the chat 
message.

Related Topics

• Chat, page 1-8

• Collaboration Checklist, page 4-1

• Using the Roster, page 4-2

Preparing for a Video Collaboration Session
To use the video collaboration features of NetMeeting, you will need to disable 
Virtual Conference Room and enable NetMeeting as follows:

Procedure

Step 1 Click the Settings toolbar icon.

Step 2 Click the Advanced tab.

Step 3 Change the collaboration setting to NetMeeting.

Step 4 Click OK.

You will need to restart Cisco IP SoftPhone for this setting to take effect.

When you restart Cisco IP SoftPhone, Cisco IP SoftPhone will place calls using 
the NetMeeting user interface. To start NetMeeting, open the roster and click the 
Launch NetMeeting Call button. See Figure 4-6.
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See the Microsoft NetMeeting online help for details on how to do use the video 
collaboration features of NetMeeting.

Figure 4-6 Launching NetMeeting

Related Topics

• Video Collaboration, page 1-8

• Collaboration Checklist, page 4-1
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Troubleshooting

These sections help you troubleshoot common problems you may experience 
when using Cisco IP SoftPhone:

• Frequently Asked Questions (FAQs), page A-1

• Finding and Changing the IP Address for the Cisco CallManager, page A-14

• Adjusting the Audio Settings, page A-16

• Diagnosing Problems with Collaboration, page A-18

Frequently Asked Questions (FAQs)
These Frequently Asked Questions (FAQs) help you resolve common problems 
you may experience with Cisco IP SoftPhone.

• When I Start Cisco IP SoftPhone, Why Don’t I See Any Lines to Control?, 
page A-2

• I Can See a Line But When I Try To Open it, Cisco IP SoftPhone Displays a 
'Could not open address' Error., page A-7

• Why Does the Audio Sound Jittery and Broken?, page A-8

• Why am I Getting One-way Audio?, page A-8

• Why Do I Get a “Could Not Initialize Audio Error” When I Start 
Cisco IP SoftPhone?, page A-13
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When I Start Cisco IP SoftPhone, Why Don’t I See Any Lines to 
Control?

There are several possible causes for this:

Possible Cause You have not selected a line.

Action Refer to the “Selecting Lines to Control” section on page 3-2.

Possible Cause You have not been assigned a line on the Cisco CallManager.

Action Ask your system administrator to assign and associate a line for you on 
the Cisco CallManager.

Possible Cause The Cisco IP SoftPhone is not properly configured to see lines. 

Action Check the Cisco IP SoftPhone configuration. See the “Verifying the 
Cisco IP SoftPhone Configuration” section on page A-3.

Possible Cause The Cisco local TSP (installed with Cisco IP SoftPhone) is not 
properly configured.

Action Verify the Cisco Local TSP configuration. See the “Verifying the 
Cisco TSP Configuration” section on page A-4.

Possible Cause The Telephony Service needs to be restarted on your computer.

Action Restart the Telephony service. See the “Restarting the Telephony 
Service” section on page A-6.
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Possible Cause You do not have proper network access.

Action Verify Network Connectivity. See the “Verifying Network 
Connectivity” section on page A-7.

Verifying the Cisco IP SoftPhone Configuration

Use this procedure to verify if local TSP (Telephony Service Provider) is enabled 
on the Cisco IP SoftPhone.

Procedure

Step 1 Click the Settings toolbar icon.

Step 2 Click the Advanced tab.

Step 3 Verify that the Use Local TSP checkbox is enabled. See Figure A-1.

Figure A-1 Enabling Local TSP

1 Check this box to enable local TSP.

1
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Step 4 Restart the Telephony service.

See the “Restarting the Telephony Service” section on page A-6.

Step 5 Launch Cisco IP SoftPhone.

If you still do not see any lines, see the “Verifying the Cisco TSP Configuration” 
section on page A-4.

Verifying the Cisco TSP Configuration

Use the following procedures to verify that the Cisco TSP is properly configured 
to communicate with the Cisco CallManager:

• Verifying the Cisco TSP Configuration for Cisco CallManager 3.1(x), 
page A-4

• Verifying the Cisco TSP Configuration for Cisco CallManager 3.0(x), 
page A-5

Note Ask your system administrator which Cisco CallManager version you 
are using for Cisco IP SoftPhone.

Verifying the Cisco TSP Configuration for Cisco CallManager 3.1(x)

Procedure

Step 1 From the Windows Control Panel, select Telephony (Windows 95/98/ME/NT) or 
Phone and Modem Options (Windows 2000).

Step 2 Click the Telephony Drivers tab (Windows 95/98/ME/NT) or Advanced tab 
(Windows 2000).

Step 3 Select Cisco TSP001.tsp in the selection box and click Configure...

If you do not see the Cisco IP PBX Service Provider telephony driver in the 
drop-down list box or if you see a listing for ciscotsp.tsp, uninstall 
Cisco IP SoftPhone and run the install program again. If you still do not see any 
lines, see your system administrator.
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Step 4 Configure (or verify) the following settings in the Cisco IP PBX Service 
Provider window:

a. Click the User tab and re-enter the username and password assigned to this 
user on the Cisco CallManager.

b. Click the CTI Manager tab and verify that the CallManager IP Address radio 
button is enabled and that the correct IP address is displayed for the 
Cisco CallManager.

If the wrong IP address is displayed, enter the correct address.

c. Click the Advanced tab and enter 15 in the “Synchronous Message Timeout” 
field 

Step 5 Click OK.

Step 6 Restart the telephony service.

See the “Restarting the Telephony Service” section on page A-6.

Step 7 Launch Cisco IP SoftPhone.

If you still do not see any lines, see the “Verifying Network Connectivity” section 
on page A-7.

Verifying the Cisco TSP Configuration for Cisco CallManager 3.0(x)

Procedure

Step 1 From the Windows Control Panel, open Telephony (Windows 95/98/ME/NT) or 
Phone and Modem Options (Windows 2000).

Step 2 Click the Telephony Drivers tab (Windows 95/98/ME/NT) or Advanced tab 
(Windows 2000).

Step 3 Select Cisco IP PBX Service Provider in the selection box and click 
Configure...

If you do not see the Cisco IP PBX Service Provider telephony driver in the 
drop-down list box or if you see a listing for ciscotsp.tsp, uninstall 
Cisco IP SoftPhone and run the install program again. If you still do not see any 
lines, see system administrator.
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Step 4 Configure (or verify) the following settings in the Cisco IP PBX Service Provider 
window:

a. In the Security section, re-enter the username and password assigned to this 
user on the Cisco CallManager.

b. In the CallManager Location section, verify that “CallManager IP Address” 
is enabled and that the correct IP address is displayed for the 
Cisco CallManager.

If the wrong IP address is displayed, enter the correct address.

c. In the “Message Timeout” section, enter 15000.

Step 5 Click OK.

Step 6 Restart the telephony service.

See the “Restarting the Telephony Service” section on page A-6.

Step 7 Launch Cisco IP SoftPhone.

If you still do not see any lines, see the “Verifying Network Connectivity” section 
on page A-7.

Restarting the Telephony Service

For Windows 95/98/ME:

Step 1 Close all applications and wait for approximately 15 seconds. If this does not fix 
the problem for which you need to restart the telephony service, restart the 
computer.

For Windows NT/2000:

Step 1 From the Windows Control Panel, open Services (Windows NT) or 
Administrative Tools and then Services (Windows 2000).

Step 2 Scroll down and select Telephony Service.

Step 3 If the status is Started, click Stop and then Start. 
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You may be unable to stop the service, especially if other processes such as the 
Remote Access Connection Manager are running. If you are unable to stop the 
service, reboot the computer.

Step 4 If you still do not see any lines, see the “Verifying Network Connectivity” section 
on page A-7.

Verifying Network Connectivity

Use this procedure to verify that the client PC has network connectivity to the 
Cisco CallManager.

Procedure

Step 1 Open a DOS window or command prompt.

Step 2 Type ping a.b.c.d where “a.b.c.d” is the IP address of your Cisco CallManager.

If you are able to communicate with the Cisco CallManager, you will receive a 
“reply” message with the Cisco CallManager IP address. If you are not able to 
communicate with the Cisco CallManager, you will receive a “request timed out” 
message. This indicates there is a network problem.

Step 3 If you do not know how to fix the problem, try rebooting the computer.

I Can See a Line But When I Try To Open it, Cisco IP SoftPhone 
Displays a 'Could not open address' Error.

Possible Cause This error typically occurs if the line has already been opened 
by another application locally or on another computer. Each line can only be 
opened once. To resolve this problem, restart the Telephony service and launch 
Cisco IP SoftPhone again.

Action Restart the Telephony service. See the “Restarting the Telephony 
Service” section on page A-6.
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Why Does the Audio Sound Jittery and Broken?
Possible Cause You are using the wrong audio drivers.

Action Select the proper audio drivers. See the “Selecting the Proper Audio 
Drivers” section on page A-8.

Selecting the Proper Audio Drivers

There are two types of audio drivers that Cisco IP SoftPhone can use: Wave audio 
drivers and DirectSound audio drivers. DirectSound audio drivers allow more than 
one application to use the speaker simultaneously; this is not possible with Wave 
audio drivers. Windows NT supports only Wave audio drivers, while Windows 
95/98/2000 support DirectSound and/or Wave audio drivers.

Procedure

Step 1 Make sure you have the latest drivers for your sound card installed.

Refer to the user documentation that came with your computer.

Step 2 Click the Settings toolbar icon.

Step 3 Click the Audio tab.

Step 4 Choose the following settings:

• For Windows NT, select the Use Wave drivers for sound card checkbox.

• For Windows 95/98/2000, de-select Use Wave drivers for sound card 
checkbox.

Why am I Getting One-way Audio?
One-way audio occurs when you fail to receive incoming audio.
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Possible Cause Your sound card is not a full-duplex card.

Action Determine whether the you have a full-duplex or half-duplex sound 
card. See the “Full-duplex vs. Half-duplex Sound Cards” section on page A-9.

Possible Cause The audio settings for your PC need adjustment.

Action Adjust the audio settings for your PC. See the “Adjusting the Audio 
Settings” section on page A-16.

Possible Cause The audio stream is being misdirected.

Explanation There are multiple Network Interface Cards (NICs) on the PC or 
the system is using Virtual Private Network (VPN) to connect to the corporate 
network.

Action Configure the Network Audio Settings. See the “Configuring Network 
Audio Settings” section on page A-10.

Full-duplex vs. Half-duplex Sound Cards

Cisco IP SoftPhone requires a full-duplex sound card for proper operation. 
Full-duplex sound cards can capture audio and play audio at the same time, thus 
allowing a conversation. The sound cards on most computers are full-duplex; 
however in rare instances you may find a computer with a half-duplex card. If you 
have one-way audio with Cisco IP SoftPhone, you may have a half-duplex sound 
card installed in your computer. 

To determine which type of sound card you have, check the documentation that 
came with your computer or sound card. You can also perform this simple test to 
determine whether you have a full-duplex or half-duplex sound card.

Procedure

Step 1 Exit Cisco IP SoftPhone.

Step 2 Launch Microsoft NetMeeting.
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Step 3 Make a Microsoft NetMeeting call to a friend running NetMeeting.

Make sure your friend is in the same building or campus and that the call does not 
go through a firewall.

Step 4 Once the call connects, begin speaking at the same time as your friend.

If you can hear your friend while you are speaking, and your friend can hear you, 
you have a full-duplex sound card.

If this test fails, you probably have a half-duplex sound card. You will need to 
install a full-duplex sound card for proper operation of Cisco IP SoftPhone.

Configuring Network Audio Settings

You should configure the Network Audio Settings when one-way audio is the 
result of one of the following conditions:

• You are running Cisco IP SoftPhone over a Virtual Private Network (VPN) to 
connect to the corporate network.

• You are using multiple Network Interface Cards (NICs) on the PC.

• You disconnect and reconnect to the network (e.g., undocking and docking a 
laptop).

Under these conditions, Cisco IP SoftPhone may use the wrong IP address. You 
can obtain the correct address by configuring the Network Audio Settings.

Before You Begin

Determine whether you have multiple NICs on your PC or whether you are using 
a VPN to connect to your corporate network.

Procedure

Step 1 Click the Settings icon.

Step 2 Click the Audio tab. See Figure A-2.
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Figure A-2 Audio Tab

Step 3 Click the Network IP Settings button to open the Network Audio Settings 
window. 

See Figure A-3.

1 Click here to configure network audio settings.

1
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Figure A-3 Network Audio Settings

Step 4 Configure your IP Address settings as follows:

If you have multiple NICs on the PC:

Choose the default setting: Automatic Selection (web installation) or Select 
Address (CD installation) and click the Update button.

If your system is using VPN to connect to the corporate network:

a. Select Automatic Selection if the URL address field contains an IP address.

b. If the URL field is blank, select Specify Address and enter the IP address that 
your VPN software is using. 

c. If you are unable to determine your VPN IP address, choose Select Address.
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Select a random address from the drop-down menu. You may need to 
randomly select a different address from the drop-down menu until you are 
able to establish two-way audio.

d. If you still experience one-way audio, contact your system administrator.

Step 5 In the UDP Port Setting area choose the default setting, Automatic Setting, for 
both Audio Input Port and Audio Output Port.

Step 6 Click the OK button.

Note To refresh the screen with the original settings, click the Refresh 
button.

Why Do I Get a “Could Not Initialize Audio Error” When I Start 
Cisco IP SoftPhone?

Possible Cause You do not have a sound card in your machine.

Action Install a full-duplex sound card in your machine.

Possible Cause You do not have the proper audio drivers installed.

Action Download the latest audio drivers for your sound card from the 
manufacturer’s website. To verify that the audio drivers, microphone, and 
speaker are working, try to record and play audio using an application such as 
Microsoft Sound Recorder. 
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Appendix A      Troubleshooting
Finding and Changing the IP Address for the Cisco CallManager
Finding and Changing the IP Address for the 
Cisco CallManager

To determine which Cisco CallManager a Cisco IP Phone is using:

Step 1 Click the Settings button on the Cisco IP Phone and then select Network 
Configuration from the menu on the LCD.

Step 2 Scroll down until you see an entry for Cisco CallManager 1.

The IP Address for the Cisco CallManager will be displayed as “Active.” This is 
the address you should use when installing Cisco IP SoftPhone.

Determining Which Cisco CallManager the Cisco IP SoftPhone is 
Using

Before You Begin

Ask your system administrator if you are using Cisco CallManager 3.1(x) or 
3.0(x).

For Windows 95/98/ME/NT

Step 1 From the Windows Control Panel, select Telephony.

Step 2 Click the Telephony Drivers tab.

Step 3 Select the Cisco TSP Service Provider in one of the following ways:

• If you are using Cisco CallManager 3.1(x), select Cisco TSP001.tsp in the 
selection box.

• If you are using Cisco CallManager 3.0(x), select Cisco IP PBX Service 
Provider in the selection box.

Step 4 Click Configure...
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Appendix A      Troubleshooting
Finding and Changing the IP Address for the Cisco CallManager
The IP Address for the Cisco CallManager you are using with Cisco IP SoftPhone 
will be displayed in the CallManager Location of the Cisco IP PBX Service 
Provider window.

If this is not the same IP address that your Cisco IP Phone is using, you will need 
to edit it to match the Cisco IP Phone IP address.

For Windows 2000

Step 1 From the Windows Control Panel, select Phone and Modem Options 

Step 2 Click the Advanced tab.

Step 3 Select the Cisco TSP Service Provider in one of the following ways:

• If you are using Cisco CallManager 3.1(x), select Cisco TSP001.tsp in the 
selection box.

• If you are using Cisco CallManager 3.0(x), select Cisco IP PBX Service 
Provider in the selection box.

Step 4 Click Configure...

The IP Address for the Cisco CallManager you are using with Cisco IP SoftPhone 
will be displayed in the CTI Manager tab section of the Cisco IP PBX Service 
Provider window.

If this is not the same IP address that your Cisco IP Phone is using, you will need 
to edit it to match the Cisco IP Phone IP address.

Changing the Cisco CalIManager IP address Configured for the 
Cisco IP SoftPhone 

For Windows 95/98/ME/NT

Step 1 Type the IP Address of the Cisco CallManager to which you want to connect in 
the CallManager Location section of the Cisco IP PBX Service Provider window.
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Appendix A      Troubleshooting
Adjusting the Audio Settings
Step 2 In the Security section of the Cisco IP PBX Service Provider window, type the 
username and password assigned to you for that Cisco CallManager.

Step 3 Click OK.

Note To use Cisco IP SoftPhone with a Cisco IP Phone, the username and password 
configured for Cisco IP SoftPhone must be exactly the same as the username 
and password assigned to this user on the Cisco CallManager.

For Windows 2000

Step 1 Click CTI Manager tab in the Cisco IP PBX Provider window and select the IP 
address radio button.

Step 2 Type the IP address of the Cisco CallManager to which you want to connect in the 
IP Address field.

Step 3 Click the User tab of the Cisco IP PBX Service Provider window and type the 
username and password assigned to you for that Cisco CallManager.

Step 4 Click OK.

Note To use Cisco IP SoftPhone with a Cisco IP Phone, the username and password 
configured for Cisco IP SoftPhone must be exactly the same as the username 
and password assigned to this user on the Cisco CallManager.

Adjusting the Audio Settings
Frequently, the volume settings on client PC’s are improperly set, preventing 
users from having two-way audio in a telephone call. Use this procedure to check 
and adjust these settings.

Procedure

Step 1 Select Start > Programs > Accessories > Multimedia > Sound Recorder.
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Appendix A      Troubleshooting
Adjusting the Audio Settings
Step 2 Record your voice using the microphone for 5-10 seconds.

Step 3 Play back the recorded voice.

If you hear your voice, your audio settings are properly set.

If you do not hear your recorded voice, close the Sound Recorder application and 
go to Step 4.

Step 4 Select Start > Programs > Accessories > Multimedia > Volume Control.

Step 5 Select Options > Properties.

Step 6 Under “Adjust volume for” select Playback.

Step 7 Under “Show the following volume controls” make sure every item in the list is 
checked.

Not all items are visible so be sure to scroll down to the end of the list.

Step 8 Click OK.

Step 9 Under “Adjust volume for” select Recording and repeat Steps 7 and 8.

Step 10 Select Options > Advanced Controls.

Note If your sound card does not support advanced controls, this feature 
will not be available.

Step 11 In the Master Out volume control window, set all the volume controls to about 80 
percent. Set all balance controls to the middle. 

Step 12 Make sure that the Mute box is not checked for the Master Out control or the Wave 
control.

Step 13 Although it may seem strange, make sure the microphone’s Mute box is checked 
in order not to route the microphone’s input directly to the multimedia speakers 
or internal speaker for your computer.

You can mute the other controls as appropriate for your voice-computing 
applications.

Step 14 Select Options > Properties and verify that you are using the proper audio device 
(sound card) to handle recording and playback.

Step 15 Repeat Steps 1 through 3.
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Appendix A      Troubleshooting
Diagnosing Problems with Collaboration
If you still cannot get the Sound Recorder application to work, you do not have a 
Cisco IP SoftPhone problem. Ask your system administrator for help in 
configuring you audio settings.

Diagnosing Problems with Collaboration

Symptom I have defined the correct Associated PC for a person in my directory 
but I still cannot collaborate with him.

Possible Cause The person has moved on the LAN/WAN (e.g., the person has 
a portable computer) and the directory services of the LAN have not yet 
updated to reflect the current IP address.

Action Wait until Cisco IP SoftPhone detects the new IP address for the 
Associated PC and try collaborating with that person again.

Symptom I have met all the conditions on the Collaboration Checklist but I still 
cannot collaborate.

Possible Cause You have not tuned the audio settings or configured user 
settings for Microsoft NetMeeting. If you install a newer version of 
NetMeeting after you install Cisco IP SoftPhone, you need to configure user 
and audio settings for NetMeeting before you can collaborate. You need only 
do this one time.

Procedure

Step 1 Launch NetMeeting from the Start > Programs menu.

Step 2 Follow the directions for tuning audio and configuring user settings.

Step 3 Quit NetMeeting.

Step 4 Restart Cisco IP SoftPhone.
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